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Preface

This guide describes how to install and configure Oracle Utilities Advanced Spatial and 
Operational Analytics (OUASA) 2.4. Oracle Utilities Business Intelligence products supports the 
following and requires installation of OUASA 2.4:

• Oracle Utilities Customer Care and Billing release 2.2.0 or 2.3.1

• Oracle Utilities Meter Data Management release 2.0.1, Service Pack 6

• Oracle Utilities Mobile Workforce Management release 2.1.0

• Oracle Utilities Network Management System release 1.9.0.3, 1.10.0.3.1, Sor 1.11.0.1

• Oracle Utilities Work and Asset Management release 1.8.1 or 1.9.0.4

Note: The single fix patches 13532002, 13518963, 13509909, 13470718, 
13462900, 13460426, 13455478, 13111451, and 13513139 (for Oracle Utilities 
Mobile Workforce Management) are prerequisites for Oracle Mobile Workforce 
Analytics.

The single fix patches 13494493 and 13554621 are prerequisites for Oracle 
Utilities Meter Data Management.

The single fix patches 12861412 and 12797646 (for Oracle Utilities Customer 
Care and Billing 2.2.0) or single fix patches 12861408, 12797637, 13464490, 
12853107, and 12860480 (for Oracle Utilities Customer Care and Billing 2.3.1) 
are prerequisites for Oracle Utilities Customer Care and Billing Business 
Intelligence.

The single fix patch 13503077 (for Oracle Utilities Network Management 
System 1.11.1) is a prerequisite for Oracle Utilities Network Management 
Business Intelligence.

Audience
This guide is intended for anyone interested in understanding or performing the process of 
installing or configuring Oracle Utilities Advanced Spatial and Operational Analytics v2.4.

Related Documents
For more information, refer to the following documents in the Oracle Utilities Advanced Spatial 
and Operational Analytics Documentation Library:

• Oracle Utilities Advanced Spatial and Operational Analytics Release Notes

• Oracle Utilities Advanced Spatial and Operational Analytics Quick Install Guide
v



• Oracle Utilities Advanced Spatial and Operational Analytics Administration Guide

• Oracle Utilities Advanced Spatial and Operational Analytics User's Guide

• Oracle Utilities Advanced Spatial and Operational Analytics Licensing and Package Guide

• Oracle Utilities Customer Care and Billing Business Intelligence Metric Reference Guide

• Oracle Utilities Meter Data Management Business Intelligence Metric Reference Guide

• Oracle Utilities Network Management Business Intelligence Metric Reference Guide

• Oracle Utilities Work and Asset Management Business Intelligence Metric Reference Guide

• Oracle Utilities Mobile Workforce Management Business Intelligence Metric Reference Guide

• Oracle Utilities Customer Care and Billing Business Intelligence Data Mapping Guide

• Oracle Utilities Meter Data Management Business Intelligence Data Mapping Guide

• Oracle Utilities Network Management Business Intelligence Data Mapping Guide

• Oracle Utilities Work and Asset Management Business Intelligence Data Mapping Guide

• Oracle Utilities Mobile Workforce Management Business Intelligence Data Mapping Guide

• Oracle Utilities Application Framework Business Process Guide 

• Oracle Utilities Application Framework Administration Guide 

• Oracle Utilities Business Intelligence Server Administration Guide

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
vi



Chapter 1 
Introduction

Oracle Utilities Advanced Spatial and Operational Analytics (OUASA), in other words, Oracle 
Business Intelligence for Utilities (OBIU), version 2.4.0 consists of the following components:

• Star schema definitions

• ETL process built on Oracle Warehouse Builder (OWB)

• Pre-built analytics' dashboards based on Oracle Business Intelligence Enterprise Edition 
(OBIEE)

• OUBI - Oracle Utilities Business Intelligence (OUBI) includes Oracle Utilities Application 
Framework (OUAF)-based application to generate process flows using OWB Code 
Generator. This is an optional component and is required only if you need to customize or 
create new custom OWB process flows. 

Note that the term OUASA would typically refer to the first three components mentioned above. 
Only these three components are required for a typical installation. This document provides 
information about these components which are commonly required by most of the customers.

What's New in OUASA v2.4.0?
Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 comes with a set of new 
functionalities. These can be divided into four groups, such as architectural changes, data 
warehouse schema, Extract-Transform-Load (ETL), and installation modifications.

Architectural Changes
The architectural changes are as follows:

• A new administration group has been added to the dashboards allowing users to administer 
and configure OBIEE. The features supported in the administration section include:

• New write back reports introduced to manage the labels in reports within OBIEE itself.

• New dashboards allowing users to view and manage load jobs. Jobs can be resubmitted 
using this dashboard.  
Refer to the "Running and Monitoring Extract Loads" section in the Oracle Utilities 
Advanced Spatial and Operational Analytics Administration Guide for details.

• The Oracle Utilities Application Framework (OUAF) component is no longer mandatory. 
Only those users who wish to make use of the code generator need to purchase licenses for 
the OUAF component.  
Refer to the "Overview of Environment Maintenance" section in the Oracle Utilities Advanced 
Spatial and Operational Analytics Administration Guide for details.
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• A new mechanism has been put in place to automatically refresh the OBIEE cache data, as 
soon as new data arrives into the warehouse.  
Refer to the "Auto Cache Refresh" section in the Oracle Utilities Advanced Spatial and Operational 
Analytics Administration Guide for details.

Schema Changes
The schema changes are as follows:

• A new group of dashboards grouped under Oracle Utilities Meter Data Analytics has been 
added. This group provides reporting metrics on the Oracle Utilities Meter Data 
Management (MDM) application. This change includes a set of eight dashboards and the 
underlying star schema to support these analytics. 
Refer to the "Oracle Utilities Meter Data Management Extractor Details" section in the Oracle 
Utilities Advanced Spatial and Operational Analytics Administration Guide for details on the extract 
methodology.

• A new group of dashboards grouped under Oracle Utilities Mobile Workforce Analytics has 
been added. This group provides reporting metrics on the Oracle Utilities Mobile Workforce 
Management (MWM) application. This change includes a set of six dashboards and the 
underlying star schema to support these analytics.  
Refer to the "Oracle Utilities Mobile Workforce Management Extractor Details" section in 
the Oracle Utilities Advanced Spatial and Operational Analytics Administration Guide for details on 
the extract methodology.

• The new dashboards now support drill back to the source edge applications (Oracle Utilities 
Meter Data Management or Oracle Utilities Mobile Workforce Management) directly from 
the reports. 
Refer to the "OUASA: Configuring Drill Back" section in the Oracle Utilities Advanced Spatial 
and Operational Analytics Administration Guide for details.

Extract-Transform-Load Changes
Following are the modifications done to the Extract-Transform-Load component:

• All load jobs is now scheduled automatically by the file processor. Users just need to extract 
files and then copy them into the load directory; the system takes care of the remaining tasks. 
Refer to the "About the File Processor Daemon" section in the Oracle Utilities Advanced Spatial 
and Operational Analytics Administration Guide details.

• New validation step has been introduced in the load jobs, to validate the number of records 
actually loaded against the number records in the flat file being loaded. Refer to the "Oracle 
Warehouse Builder Transformations" in the Oracle Utilities Advanced Spatial and Operational 
Analytics Administration Guide for details.

• All workflows will be enabled for parallel processing; however, the degree of parallelism is set 
to 1. Customers will need to change the degree based on their data volumes processing 
capabilities.  
Refer to the "Parallelism and Partitioning" section in the Oracle Utilities Advanced Spatial and 
Operational Analytics Administration Guide for details.

• Additional workflows have been provided for purging the Oracle Workflow runtime audit 
tables. These have to be scheduled by the customer.  
Refer to the "Purging Audit Records" section in the Oracle Utilities Advanced Spatial and 
Operational Analytics Administration Guide for details.

Installation Changes
The modifications during the installation process are listed as follows: 
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• Oracle MetaBase (OMB) Plus scripts will be delivered to automate the import of the released 
Oralce Warehouse Builder (OWB) Metadata Loader (MDL) files and the configuration and 
deployment of the OWB objects.

• Install scripts will retain customizations for parallel settings during upgrades.
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Chapter 2 
Installation Overview

Oracle Utilities Advanced Spatial and Operational Analytics (OUASA) consist of several 
components each of which needs to be installed for a successful installation. See Installation 
Components for the list of components comprising the Oracle Utilities Advanced Spatial and 
Operational Analytics product.

Certain prerequisite software may need to be installed for installing each of these components. See 
Prerequisite Software for the list of prerequisite software necessary for installing each 
component.
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The following figure shows the workflow for the initial installation process:
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The following figure shows the workflow for the upgrade process.
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Installation Components
Installation Components
The Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 product installation 
consists of the following installable components.

Each of the components listed below has to be installed to complete the Oracle Utilities Advanced 
Spatial and Operational Analytics installation.

• OUASA Database component containing star schemas and product metadata

• OUASA ETL workflows based on Oracle Warehouse Builder (OWB) 
Note that the OUASA ETL component should be installed on database server.

• OUASA Dashboards components and answers based on Oracle Business Intelligence 
Enterprise Edition (OBIEE) 
Note that the OUASA Dashboard components should be installed where OBIEE 11.1.1.5 is 
installed on the server 

Oracle Utilities Advanced Spatial and Operational Analytics also includes a demo database with 
pre-populated data that can be used for training or demonstration purposes.

Installation Types
The first step in the installation procedure is to determine the installation type based on the 
customer installation scenario. The following are the possible installation types:

• Initial install, an installation from scratch

• Upgrade, an upgrade from an earlier version to version 2.4.0

• Demo data install, an installation with pre-populated demo data

The following sections describe each type of installation, in detail

Initial Installation
This installation type is applicable when installing Oracle Utilities Advanced Spatial and 
Operational Analytics for the first time or from scratch. Each of the following components should 
be installed during an initial installation.

• OUASA Database component 

• OUASA ETL component based on OWB

• OUASA Dashboard component based on OBIEE

See Installing Oracle Utilities Advanced Spatial and Operational Analytics for the steps 
involved in installing each of the above components.

Upgrade
This installation type is applicable when upgrading to Oracle Utilities Advanced Spatial and 
Operational Analytics v2.4.0 from an earlier version.  
Refer to the section Supported Upgrade Paths to find out whether upgrade of your particular 
version is supported.

Each of the following components should be installed during an upgrade installation.

• OUASA Database component 

• OUASA ETL component based on OWB

• OUASA Dashboard component based on OBIEE
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Installation Components
Refer to Upgrading to Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 
for the steps involved in upgrading each of the above components.

Demo Installation
This installation type is applicable when installing the demo database component of Oracle 
Utilities Advanced Spatial and Operational Analytics for demonstration or training purposes. The 
following components should be installed for a demo installation:

• OUASA Demo database components

• OUASA Dashboard components based on OBIEE

Refer to Demo Installation Procedure for the steps involved in installing each of the above 
components.

Media Pack Contents
Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Media Pack consists of the 
following documentation and installation packages.

Documentation Packages
• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Release Notes

• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Quick Install Guide

• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Installation and 
Configuration Documentation

• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 User Documentation

• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Supplemental 
Documentation

Installation Packages
• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Multiplatform

• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Oracle Database

Note: The Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 
Multiplatform package contains the installer for both the ETL component and 
Dashboard component.

Additional Software Requirements
The following additional software products are required to run Oracle Utilities Advanced Spatial 
and Operational Analytics, but are not included in the Media Pack:

• Oracle Business Intelligence Enterprise Edition 11.1.1.5.0

• Oracle Database Server Enterprise Edition 11.2.0.2 with Oracle Warehouse Builder

• Oracle Client 11.2.0.2 Software 32 bit Windows

• Java 1.6 or higher

• Oracle Warehouse Builder Client 32bit Windows
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Supported Source Application Versions
Supported Source Application Versions
The following are the supported source application versions

Source Application Version

Oracle Utilities Customer Care & Billing 2.2.0
2.3.1

Oracle Utilities Network Management 
System

1.9.0.3
1.10.0.3.1
1.11.0.1

Oracle Utilities Work & Asset Management 1.8.1
1.9.0.4

Oracle Utilities Meter Data Management 2.0.1.6

Oracle Utilities Mobile Workforce 
Management

2.1.0

Architecture
The following figure shows the architecture of the Oracle Utilities Advanced Spatial and 
Operational Analytics (OUASA) product:
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Chapter 3 
System Requirements and Supported Platforms

Operating Systems and Application Servers
This installation has been certified to operate on many operating system, application server, and 
database server combinations. For the software requirements for each of these combinations, refer 
to the Oracle Utilities Advanced Spatial and Operational Analytics Installation Guide.

The following table details the browser, operating system, and application server combinations on 
which Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 has been tested and 
certified.

OBIEE Browser Operating System 
(Client)

Operating System
(Server) Chipset Application 

Server Database

11.1.1.5

IE 7.x 

IE 8.x

Firefox 3.x 
(OBIEE 

only)

Windows XP SP3

Windows 7

AIX 6.1 (64-bit) Power  
64-bit

WebLogic 
10.3.5

Oracle 11.2.0.2

Oracle Linux 5.6 (64-bit)
Red Hat Enterprise 
Linux 5.6 (64-bit)

x86_64  WebLogic 
10.3.5

Oracle 11.2.0.2

Sun Solaris 10 (64-bit) SPARC WebLogic 
10.3.5

Oracle 11.2.0.2

Windows 2008 Server 
SP2 (32-bit)

x86_64 WebLogic 
10.3.5

Oracle 11.2.0.2

Additional Notes on Supported Platforms
Following topics are discussed in this section: 

• Oracle's Unbreakable Enterprise Kernel

• Oracle Database Server

• Oracle VM Support

• Oracle Support Policy on VMWare

Oracle's Unbreakable Enterprise Kernel
Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 is supported on Oracle's 
Unbreakable Enterprise Kernel.
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Oracle Database Server 
Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 is supported on Oracle 
Database Enterprise Edition Server 11.2.0.2 on any of the operating systems listed above.

Oracle VM Support
Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 is supported on Oracle VM 
2.2.1 for supported releases of Oracle Linux and Microsoft Windows operating systems.

Oracle Support Policy on VMWare
Refer to My Oracle Support knowledge base article 249212.1 for Oracle's support policy on 
VMWare.
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Chapter 4 
Planning the Installation

This chapter provides information for planning an Oracle Utilities Business Intelligence 
installation, including:

• Before You Install

• Prerequisite Software

• Installation Checklist
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Before You Install
Before You Install
Refer to article 1391459.1 on My Oracle Support (https://support.oracle.com/) for latest updated 
information on Oracle Utilities Advanced Spatial and Operational Analytics installation.

Prerequisite Software
For installing Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 few prerequisite 
software needs to be downloaded and installed. Download and install these software as per the 
instructions in the respective installation documents.

The following sections list the prerequisite software for each of the product components of 
Oracle Utilities Advanced Spatial and Operational Analytics:

• Prerequisite Software for OUASA Database Component

• Prerequisite Software for OUASA ETL Component

• Prerequisite Software for OUASA Dashboard Component

Prerequisite Software for OUASA Database Component
The prerequisite software for OUASA database component is as follows:

• Oracle Database Server Enterprise Edition 11.2.0.2: This is required for installing the 
database component of the Oracle Utilities Advanced Spatial and Operational Analytics 
product.

Prerequisite Software for OUASA ETL Component
The prerequisite softwares for OUASA ETL component are as follows:

• Oracle Database Server Enterprise Edition 11.2.0.2 with Oracle Warehouse Builder 11.2.0.2.

• Oracle Warehouse Builder 11.2.0.2 client is required by the installation scripts.

• Java 6 is required for running the File Processor Daemon. 

Prerequisite Software for OUASA Dashboard Component
The prerequisite softwares for OUASA dashboard component are as follows:

• Oracle Business Intelligence Enterprise Edition 11.1.1.5.0 with Enterprise Install Option

• Oracle 11.2.0.2 Client is required by the installation scripts for installing the OBIEE 
dashboard component.

Installation Checklist
The following checklist will guide you through the installation process of Oracle Utilities 
Advanced Spatial and Operational Analytics v2.4.0.

The details for each step are presented in subsequent chapters.

1. Install prerequisite software. See Prerequisite Software for more details.

2. Determine the installation type. See Initial Installation Procedure to determine the 
installation type for your scenario. Perform the installation steps as applicable to your 
installation type.

3. Install the following Oracle Utilities Advanced Spatial and Operational Analytics 
components:
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Before You Install
• OUASA Database component

• OUASA ETL component

• OUASA OBIEE dashboard component

Refer to Installing Oracle Utilities Advanced Spatial and Operational Analytics for 
instructions about fresh or initial installation.

For upgrading from an earlier version to v2.4.0, refer to Upgrading to Oracle Utilities 
Advanced Spatial and Operational Analytics v2.4.0.

4. Perform post-installation tasks and configure the application. 

5. Refer o After the Installation section under the respective chapters of your selected 
installation type.
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Chapter 5 
Installing Oracle Utilities Advanced Spatial and 

Operational Analytics

This chapter provides instructions for installing Oracle Utilities Advanced Spatial and Operational 
Analytics.

The chapter includes the following topics: 

• Before You Install

• Initial Installation Procedure

Before You Install
Refer to article 1391459.1 on My Oracle Support for up-to-date additional information on Oracle 
Utilities Advanced Spatial and Operational Analytics installation.

Initial Installation Procedure
The following topics are discussed in this section: 

• OUASA Database Component Installation

• OUASA ETL Component Installation

• OUASA Dashboard Component Installation

• After the Installation

OUASA Database Component Installation
This section describes how to install the database component of Oracle Utilities Advanced Spatial 
and Operational Analytics. The section includes the following topics:

• Copying and Decompressing Install Media

• Database Creation

• DWADM Schema Installation

• Spatial Configuration

Copying and Decompressing Install Media
To copy and decompress the install media, perform these steps:

1. Download the Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Oracle 
Database part from Oracle Software Delivery Cloud (https://edelivery.oracle.com/).
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2. Create a temporary directory, such as c:\ouasa\temp or /ouasa/temp. (Referred to below as 
<TEMPDIR>) This directory must be located outside any current working Oracle Utilities 
application environment. All files that are placed in this directory as a part of the installation 
can be deleted after completing a successful installation.

3. Copy the file OUASA-V2.4.0-Database-Multiplatform.zip from the delivered package to the 
<TEMPDIR>.

4. Unzip the zip file using any zip utility.

Database Creation
Ensure that Oracle Database Server Enterprise Edition 11.2.0.2 is already installed on machine in 
order to create database and OWB patch 12874883 is also applied to Oracle Home.

Note that you can follow either of the two procedures mentioned below for creating a database. 
After creating a database, proceed to procedure mentioned in section DWADM Schema 
Installation.

You can create a database in any of the following two ways:

• Database creation using the DBCA utility

• Database creation using database creation tool (cdxdba.plx for UNIX or CDXDBA.exe for 
Windows) packaged with product.

Note: After following either of the two procedures for creating a database, 
proceed to and follow the procedures mentioned in section DWADM Schema 
Installation.

Database Creation Using DBCA
For an initial installation database creation, it is recommended that you use the Database 
Configuration Assistant (DBCA) to create a data warehouse database with below-mentioned 
specifications:

1. Create a database with the AL32UTF8 character set. Set the open cursor limit to 3000 and 
processes to 1000.

2. In the database, set the query_rewrite_enabled parameter to FORCE and the 
query_rewrite_integrity parameter to TRUSTED.

3. Connect to sys user and execute the following commands:

alter system set query_rewrite_enabled=force;

alter system set query_rewrite_integrity=trusted;

4. After the database is created, create the DWADM, DWUSER, and DWREAD users in the 
database, along with the CISTS_01 tablespace that is assigned as the default tablespace to 
DWADM, DWUSER, and DWREAD users. 
The DW_USER and DW_READ roles must be created in the database and the DWUSER 
user should be assigned both roles. The DWREAD user should be assigned only the 
DW_READ role.

Note: Refer to ../BI240/DatabaseCreation/Unix/11g/users.sql to create the 
users and roles mentioned above.

Database Creation Using CDXDBA
Note: The UNIX and Windows database creation utilities will create an empty 
database with AL32UTF8 character set and at least one tablespace for storing 
the application objects before running the installation. The default name of the 
application tablespace is CISTS_01. 

UNIX Database Creation Utility
The files are located in ../BI240/DatabaseCreation/Unix.
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1. FTP the contents of the Database Creation folder to a temporary directory on the UNIX 
server.

2. To create the database, set the ORACLE_HOME and the ORACLE_BASE variables.

3. Execute the utility cdxdba.plx by executing the following command:

perl cdxdba.plx

4. Provide the following parameter values when the script prompts:

Instance name (DEMO): DEMO

ORACLE_BASE: the directory where the setup files for the database will be created (/
orasw/app/oracle):

ORACLE_HOME: the folder where the current version of Oracle software is installed 
(/orasw/app/oracle/product/):

ORACLE_DATA: the directory where the data files for the database will be created (/
db05/oradata):

Character set for the database (AL32UTF8):

5. Enter the values based on the settings of your database server. You can also accept the default 
values displayed if they match your database server settings. You will be prompted to confirm 
the settings and select Y or N to create the database.

ORACLE_SID: DEMO

ORACLE_HOME: /orasw/app/oracle/product/

ORACLE_BASE: /orasw/app/oracle

ORACLE_DATA: /db05/oradata

Character Set: AL32UTF8

Do you want to continue (Y/N)?

6. When the database has been created, you will be prompted with the following questions:

Do you want to import a demo database dump into this database (Y/N)?

Select N to exit the database utility.

Set the query_rewrite_enabled parameter to FORCE and the query_rewrite_integrity parameter to 
TRUSTED in the database.

Connect to sys user and execute the following commands:

alter system set query_rewrite_enabled=force;

alter system set query_rewrite_integrity=trusted;

Update the oratab  file for the new database and then check the connectivity to this database from 
another server and from your desktop after updating local tnsnames.ora file.

Windows Database Creation Utility
The files are located in ..\BI240\DatabaseCreation\Windows. 

You should be logged in as a user who is a member of local ORA_DBA group on that server. The 
ORA_DBA group should have "administrator" privileges assigned to it.

1. To create a database, run the utility CDXDBA.exe located in the Windows folder from 
command prompt. The utility displays the following options:

E - Export a schema from the database

R - Refresh a schema with a database dump
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C - Create/Recreate a local database

H - See help for the command line options

Q - Quit

2. Select option C to create an empty database on your machine and provide below inputs.

3. Provide the instance name (DEMO) : <DB Name> e.g BIDEMO

4. Enter the character set of the database (AL32UTF8) : AL32UTF8

5. Enter ORACLE_BASE: the directory where the setup files for the database will be created 
(c:\oracle) :    <Oracle_Base>  e.g. c:\app\oracle

6. Enter ORACLE_HOME: the folder where the current version of Oracle software is installed 
(c:\oracle\product\11.1.0.6\Db_1) :<Oracle_Home> e.g  c:\app\oracle\db_home

7. Enter ORACLE_DATA: the directory where the data files for the database will be created 
(c:\app\oracle\oradata) :<Directory where data files will be created>

8. Select option Q to exit the utility after database creation.

Set the query_rewrite_enabled parameter to FORCE and the query_rewrite_integrity parameter to 
TRUSTED in database.

Connect to sys user and execute the following commands:

alter system set query_rewrite_enabled=force;

alter system set query_rewrite_integrity=trusted;

Check the connectivity to this database from another server and from your desktop after updating 
local tnsnames.ora file.

DWADM Schema Installation
This section describes the initial installation of DWADM schema. The process prompts you for 
the names of three database users:

• A user that will own the application schema. For example, DWADM.

• A user that has read-write (select/update/insert/delete) privileges to the objects in the 
application schema. The application accesses the database as this user. For example, 
DWUSER.

• A user with read-only privileges to the objects in the application schema. For example, 
DWREAD.

The process also prompts you for the following:

• A database role that has read-write (select/update/insert/delete) privileges to the objects in 
the application schema. The application will access the database as this user. For example, 
DW_USER.

• A database role with read-only privileges to the objects in the application schema. For 
example, DW_READ.

• Location for jar files. (The Jar files are bundled with the database package.)

• Java Home. For example, C:\Java\jdk1.6.0_18

Review Storage.par
The storage.par file (that comes with the product) allocates all base tables and indexes to the 
default tablespace CISTS_01. If you decide to allocate some tables or indexes outside of the 
default tablespace, then this has to be reflected in the storage.par file by changing the tablespace 
name from the default value to a custom value, according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments
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Where Parallel defines the number of threads that the Oracle DB Server uses to access a table or 
create an index. Default value is 1.

Installing DWADM Schema
Perform the following steps to install the DWADM schema:

Note: Ensure to run CDXDBI.exe from a Window 32-bit desktop that has the 
Oracle 11.2.0.2 client and Java Development Kit Version 6.0 Update 20 or later.

1. Run CDXDBI.exe from ..\BI240\DWADM\Install-Upgrade. Please run the utility from 
command prompt. The utility prompts you to enter values for the following parameters:

• Name of the target database:<DB NAME>

• Password for the SYSTEM user account in the database (in silent mode)

• Name of the owner of the Database Schema:<DWADM>

• Location of Java Home: <..\jdk1.6.0_20>

• Location of TUGBU Jar files: <..\BI240\DWADM\Jarfiles>

• Password for the user (in silent mode)

• Oracle user with read-write privileges to the Database Schema:<DWUSER>

• Oracle user with read-only privileges to the Database Schema:<DWREAD>

• Oracle database role with read-write privileges to the Database Schema:<DW_USER>

• Oracle database role with read-only privileges to the Database Schema:<DW_READ>

2. If you choose to continue, CDXDBI first checks for the existence of each of the users 
specified and prompts for their password, default tablespace, and temporary tablespace, if 
they do not exist.

3. After setting up roles and users, the utility continues upgrading schema and system data 
definitions. If an error occurs while executing an SQL or another utility, it logs and displays 
the error message and allows you to re-execute the current step.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
starting to use the database, generate the statistics for these new objects.

Spatial Configuration
See Spatial Configuration to configure spatial data.

OUASA ETL Component Installation
This section describes how to install the ETL component of Oracle Utilities Advanced Spatial and 
Operational Analytics. The section includes the following:

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• Creating and Configuring Oracle Warehouse Builder Workspace

• OUASA ETL Package Installation Steps

• Post-installation Tasks

Copying and Decompressing Install Media
The Oracle Utilities Advanced Spatial and Operational Analytics application server installation file 
is delivered in jar format for both UNIX and Windows platforms. If you plan to install multiple 
Oracle Utilities Advanced Spatial and Operational Analytics environments operated by different 
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Oracle Utilities Administrator user IDs, you must complete each of the following installation steps 
for each Administrator user ID.

1. Log in to the Database server host as the Oracle Utilities Advanced Spatial and Operational 
Analytics administrator user ID (default cases).

2. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp. (Referred to 
below as <TEMPDIR>.) This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation. 

3. Copy the file OUASA.V2.4.0-MultiPlatform.jar from the delivered package to the 
<TEMPDIR>. If you use FTP to transfer this file, remember to use the BINARY option for 
the FTP transfer.

4. Decompress the file as follows:

cd <TEMPDIR>

jar -xvf OUASA.V2.4.0-MultiPlatform.jar

Note: You should have Java JDK installed on the machine used to (un)jar the 
application server installation package. Install the JDK that is supported for the 
install on your platform to be able to use the jar command.

The Java packages are located at: http://java.sun.com/products/archive/index.html

A sub-directory named "OUBI.V2.4.0" is created. It contains the installation software for the 
Oracle Utilities Advanced Spatial and Operation Analytics application server.

Setting Permissions for cistab File in UNIX
Every Oracle Utilities Advanced Spatial and Operational Analytics environment installed on a 
server must be registered in the /etc/cistab file located on that server. On UNIX servers, generally 
only the root user ID has write permissions to the /etc directory. Since the installation process is 
run by the Oracle administrator user ID (cissys), this user ID may not be able to write to /etc/
cistab table.

The install utility checks permissions and if it identifies a lack of necessary permissions, it 
generates a script in the <TEMPDIR>/OUBI.V2.4.0 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Advanced Spatial and Operational Analytics application environment on the 
server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Advanced 
Spatial and Operational Analytics administrator user ID, so that the next time a new environment 
is created by the same Oracle Utilities Advanced Spatial and Operational Analytics administrator 
user ID, you do not need to run the generated script with the root user ID. Instead, the install 
utility itself proceeds with the registration.

If you are re-installing an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you plan to upgrade an existing environment, you must ensure to take a backup prior to the 
installation process. The installation utility does not create a backup of existing environment.

Creating and Configuring Oracle Warehouse Builder Workspace
This section describes how create and configure Oracle Warehouse Builder Workspace. It also 
includes details about the following:

• Pre-deployment Steps for Initial Installation

• Creating and Configuring Workspace for an Initial Installation
5-6 Oracle Utilities Advanced Spatial and Operational Analytics Installation Guide



Pre-deployment Steps for Initial Installation
Before creating/configuring workspace follow these steps:

1. Execute $ORACLE_HOME/owb/wf/install/wfinstall.csh to configure the workflow in 
database with OWFMGR as user and OWFMGR as password.

2. Install the OWB client 11.2.0.2 on a Windows 32-bit machine.  
Refer to the Oracle Warehouse Builder Installation and Configuration Guide to install and 
configure OWB.  
The configuration guide is available at: http://www.oracle.com/technology/documentation/
warehouse.htm.

3. Apply 12874883 OWB patch to the database server and the OWB client if already not 
applied.

Creating and Configuring Workspace for an Initial Installation
To configure the OWB workspace, follow these steps:

1. Run the $ORACLE_HOME/owb/bin/unix/reposinst.sh command for UNIX from the 
database server.

or

Invoke the repository assistant from Warehouse Builder > Administrator for Windows from 
the database server or client.

2. Provide the following information:

1. Database connection details and click Next.

2. Select Manage Warehouse Builder Workspaces and click Next.

3. Select Create a new Warehouse Builder Workspace and click Next.

4. Select Workspace with a new user as the workspace owner.

5. Provide the system user password.

6. Execute cat_owb.sql as sysdba from <OWBHOME>/owb/UnifiedRepos directory, when 
prompted.

7. Unlock the OWBSYS and OWBSYS _AUDIT accounts using the following commands, if 
this has not already been done.

Connect to sys user and execute the following commands:

ALTER USER OWBSYS IDENTIFIED BY OWBSYS ACCOUNT UNLOCK;

ALTER USER OWBSYS _AUDIT IDENTIFIED BY OWBSYS _AUDIT 
ACCOUNT UNLOCK;

8. Check only Data Integrator Enterprise Edition on Enable Optional Features, and then 
specify the following details:

Workspace Owner's user Name: BIREPOWN

Workspace Owner's password: BIREPOWN

Workspace Name: SPLBIREP

Provide OWBSYS Password:

9. Execute <OWBHOME>/owb/UnifiedRepos /remote_owb_install.sql after logging in to 
sys user, if promoted. When prompted for Oracle Home for Remote OWB software, provide 
the location of OWB Oracle Home.

10. Provide the tablespace info for the OWB workspace schema.

11. Select the Language. (American Language)
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12. Select the Target Schema (DWADM) and Workflow Schema (OWFMGR) from the available 
Repository Users List and move them to Selected. This will register the DWADM and 
OWFMGR schemas with the workspace.

13. On the same screen, click Create New User to create a new workspace user. Specify the 
following details:

User Name: BIREPO

Password: BIREPO

14. Review the information and then click Finish to complete the workspace configuration.

15. Modify the contents of <owb-home>/owb/bin/admin/Runtime.properties file from the 
following to the contents mentioned later.

property.RuntimePlatform.0.NativeExecution.FTP.security_constraint = DISABLED 

property.RuntimePlatform.0.NativeExecution.Shell.security_constraint = DISABLED

property.RuntimePlatform.0.NativeExecution.SQLPlus.security_constraint = 
DISABLED

To

property.RuntimePlatform.0.NativeExecution.FTP.security_constraint = 
NATIVE_JAVA

property.RuntimePlatform.0.NativeExecution.Shell.security_constraint = 
NATIVE_JAVA

property.RuntimePlatform.0.NativeExecution.SQLPlus.security_constraint = 
NATIVE_JAVA

16. Connect to OWBSYS user and execute <owb-home>/owb/rtp/sql/stop_service.sql.

17. Connect to OWBSYS user and execute <owb-home>/owb/rtp/sql/start_service.sql.

18. Connect to database with sys user and execute the following procedures:

Note: Before executing these procedures modify  <SMTP SERVER> and 
<SMTP PORT> to appropriate values.

EXECUTE DBMS_NETWORK_ACL_ADMIN.CREATE_ACL('acl_for_owb_cc.xml',
'ACL for Control Center','OWBSYS', TRUE, 'connect');
EXECUTE
DBMS_NETWORK_ACL_ADMIN.ASSIGN_ACL('acl_for_owb_cc.xml',<SMPT
SERVER>, <SMPT PORT>);
COMMIT;

19. Execute the following:

SELECT acl,host,
DECODE(DBMS_NETWORK_ACL_ADMIN.check_privilege_aclid(aclid,
'OWBSYS', 'connect'),1, 'GRANTED', 0, 'DENIED', NULL) privilege
FROM dba_network_acls ;
You will see the following:
/sys/acls/acl_for_owb_cc.xml
<SMPT SERVER>
GRANTED

20. Connect to BIREPOWN user and run spl_exec_wf_prc.sql.

Note: spl_exec_wf_prc.sql is located in ../BI240/Scripts.

21. Connect to DWADM schema and execute spl_oms_snapshot_pkg.sql.

Note: spl_oms_snapshot_pkg.sql is located in ../BI240/Scripts.

22. Connect to database with sys user and execute the following SQL statements:

DROP SYNONYM DWADM.WB_RT_AUDIT;
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CREATE SYNONYM DWADM.WB_RT_AUDIT FOR OWBSYS.WB_RT_AUDIT;
GRANT SELECT ON OWBSYS.WB_RT_AUDIT TO DWADM;
GRANT SELECT ON OWBSYS.ALL_RT_AUDIT_EXECUTIONS TO DWADM;
GRANT ALL ON OWBSYS.WB_RT_AUDIT_PURGE TO DWADM;
GRANT ALL ON OWFMGR.WF_PURGE TO DWADM;
GRANT SELECT_CATALOG_ROLE TO BIREPOWN;
GRANT ALL ON OWBSYS.WB_RT_AUDIT_EXECUTIONS TO DWADM;
GRANT ALL ON OWBSYS.WB_RT_DEF_EXECUTION_OPERATORS TO DWADM;
DROP SYNONYM DWADM.WB_RT_AUDIT_EXECUTIONS;
DROP SYNONYM DWADM.WB_RT_DEF_EXECUTION_OPERATORS;
CREATE SYNONYM DWADM.WB_RT_AUDIT_EXECUTIONS FOR
OWBSYS.WB_RT_AUDIT_EXECUTIONS;
CREATE SYNONYM DWADM.WB_RT_DEF_EXECUTION_OPERATORS FOR
OWBSYS.WB_RT_DEF_EXECUTION_OPERATORS;
alter system set query_rewrite_enabled=force;
alter system set query_rewrite_integrity=trusted;

OUASA ETL Package Installation Steps
Follow these steps to install the OUASA Package applications after the above steps performed to 
deploy the ETL Component Objects:

1. Change to the <TEMPDIR>/OUBI.V2.4.0 directory. 

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer.

3. Oracle Database Enterprise Edition 11.2.0.2 Installed User should be having privilege to 
install OUASA Package.

4. Execute the following script:

For UNIX:

export  ORACLE_CLIENT_HOME=<oracle_client_home>

export  PERL_HOME=$ORACLE_CLIENT_HOME/perl

export  PATH=$PATH:$PERL_HOME/bin

ksh ./install_OUBI.sh

For Windows:

set  ORACLE_CLIENT_HOME=<oracle_client_home>

set  PERL_HOME=%ORACLE_CLIENT_HOME%\perl

set  PATH=%PERL_HOME%\bin;%PATH%

Install_OUBI.cmd

Note: On UNIX, ensure that you have the proper execute permission on 
install_OUBI.sh.

5. The Oracle Utilities Advanced Spatial and Operational Analytics specific menu appears.

6. Under the Installation Options, enter “OWB”.

7. Select each menu item to configure the values. For detailed description of the values, see 
Configuration Worksheet for ETL Component Installation.

************************************************

Environment Installation Options: *

************************************
1.
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       Oracle Client Home Directory:
       Installation Options:

2.
       Environment Mount Point:                 
       Log Files Mount Point:                   
       Environment Name:                        
       Web Java Home Directory:                 
       Database Home Directory:                 
       Database Type:                           oracle

Each item in the above list should be configured for a successful 
install.

Choose option (1,2, <P> Process, <X> Exit):

*****************************

* Environment Configuration *

*****************************

1. Environment Description
       Environment Description:                           

2. OBIEE Environment Configuration

3. Database Configuration
       OWB WorkSpace Owner:                              
       OWB WorkSpace Owner Password:                      
       Database Name:                                     
       Database Server:                                   
       Database Port:                                     

4. DESIGN REPOSITORY CONFIGURATION
       OWB WorkSpace User:                                
       OWB Workspace user Password:                       
       OWB WorkSpace Name:                                
       DWADM SCHEMA NAME:                                 
       DWADM SCHEMA Password:                             
       WORKFLOW MANAGER SCHEMA NAME:                      
       WORKFLOW MANAGER SCHEMA Password:                 

5. DATABASE CHARACTER SET CONFIGURATION
       Database Character set:                            AL32UTF8

6. EDITING PROCESS FLOW CONFIGURATION
       Repository Operating System:                       
       Perl Compiler location:                            
       Data and control files location:                   
       Separator to be used:                              
       File Manager location:                             

7. EMAIL CONFIGURATION
       Email ID of Sender:                                
       Email ID for Reply-To address:                     
       Email ID of Receiver:                              
       SMTP server:                                       
       SMTP server port:                                  

8. CONTROL CENTRE CONFIGURATION
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       Repository Control Center Name:                    

9. EXTERNAL DATA SOURCE CONFIGURATION
       Path of the External Datasource:                   
       Path of the External Datasource LOG:               
       File Processor Daemon Execution Switch:            1
       File Processor Extract Max Load:                   5
       File Processor Scheduler Poll Duration:            60

Each item in the above list should be configured for a successful 
install.

Choose option (1,2,3,4,5,6,7,8,9, <P> Process, <X> Exit):

8. When you are done with the parameter setup, proceed with the option P. Write to the 
configure file.

9. Once the install has finished successfully, you execute the post-installation steps as described 
in Post-installation Tasks.

Post-installation Tasks
The following post-installation tasks are discussed in this section:

Deploying ETL Workflows on Oracle Warehouse Builder
Deploy the ETL work flows to target BI database configured in OUASA package installation.

In UNIX, you may get a Java heap space error while importing the MDL file. To resolve this error 
you may need to make change in OMBPlus.sh file, located at: $ORACLE_HOME/owb/bin/
unix/OMBPlus.sh

In the following code, change the value -Xmx768M to -Xmx1024M, and then the -Dlimit value 
768M to 1024M.

$JAVAPATH/bin/java $JAVA64FLAG -Xms64M -Xmx768M $OPTS -Dlimit=768M -
DORACLE_HOME=$ORACLE_HOME -DOWBCC_HOME=$ORACLE_HOME -
DTCLLIBPATH="$TCLLIBPATH" -
DMARATHON_RETRY_COUNT="$MARATHON_RETRY_COUNT" -
DMARATHON_RETRY_INTERVAL="$MARATHON_RETRY_INTERVAL" 
$CLASSPATH_LAUNCHER oracle.owb.scripting.OMBShell $*

You may need to make this value larger than 1024MB (1GB) depending on the size of the import.

Perform the following tasks:

• Deploying OWB Workflows

• Deploying Materialized Views

• Generating Security

• Generating Database Statistics

Deploying OWB Workflows
Review the parallel-* .txt files located under the $SPLEBASE/etc folder to set the degree of 
parallelism. The files are in the parallel*.txt format to change the <Degree> of parallelism.

parallel-tables.txt file format: <Object_name>:<Degree>

parallel-mvs.txt file format: <MV_Name>:<Fact_Table>:<Degree>

parallel-maps.txt file format: <Object_name>:<Table_Name>:<Degree>

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.
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Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

Run Ksh ./Owbdeploy.sh

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%\bin

Run Owbdeploy.cmd

Deploying Materialized Views
For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

Run Ksh ./ installViews.sh

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%\bin

Run installViews.cmd

Once the deployment is completed, remove the $SPLEBASE/tmp content to ensure all the 
complete files are removed.

cd $SPLEBASE/tmp

Generating Security
Edit the database name with the name of your database in OraGenSec.bat after completing the 
OWB deployment and run it from BI240/DWADM/Security folder.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
starting to use the database, generate the statistics for these new objects.

OUASA Dashboard Component Installation
This section describes how to install the database component of Oracle Utilities Advanced Spatial 
and Operational Analytics. The section includes the following:

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• OUASA Dashboard Package Installation Steps

• Post-installation Tasks

Copying and Decompressing Install Media
The Oracle Utilities Advanced Spatial and Operational Analytics application server installation file 
is delivered in jar format for both UNIX and Windows platforms. If you plan to install multiple 
Oracle Utilities Advanced Spatial and Operational Analytics environments operated by different 
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Oracle Utilities Administrator user IDs, you must complete each of the following installation steps 
for each Administrator user ID.

1. Log in to the application server host (where OBIEE 11.1.1.5.0 software is installed) as the 
Oracle Utilities Advanced Spatial and Operational Analytics administrator user ID (default 
ceases).

2. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp. (Referred to 
below as <TEMPDIR>.) This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation.

3. Copy the file OUASA.V2.4.0-MultiPlatform.jar from the delivered package to the 
<TEMPDIR>. If you are using FTP to transfer this file, remember to use the BINARY 
option for the FTP transfer.

4. Decompress the file:

cd <TEMPDIR>

jar -xvf OUASA.V2.4.0-MultiPlatform.jar

Note: You will need to have Java JDK installed on the machine used to (un)jar 
the application server installation package. Install the JDK that is supported for 
the install on your platform to be able to use the jar command.

The Java packages are located at: http://java.sun.com/products/archive/index.html

A sub-directory named "OUBI.V2.4.0" is created. It contains the installation software for the 
Oracle Utilities Business Intelligence application server.

Setting Permissions for cistab File in UNIX
Every Oracle Utilities Advanced Spatial and Operational Analytics environment installed on a 
server must be registered in the /etc/cistab file located on that server. On UNIX servers, generally 
only the root user ID has write permissions to the /etc directory. Since the installation process is 
run by the Oracle administrator user ID (cissys), this user ID may not be able to write to /etc/
cistab table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/OUBI.V2.4.0 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Advanced Spatial and Operational Analytics application environment on the 
server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Advanced 
Spatial and Operational Analytics administrator user ID, so that the next time a new environment 
is created by the same Oracle Utilities Advanced Spatial and Operational Analytics administrator 
user ID, you do not need to run the generated script with the root user ID. Instead, the install 
utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you plan to upgrade an existing environment it is recommended that you take a backup prior to 
the installation process. The installation utility does not create a backup of existing environment.

OUASA Dashboard Package Installation Steps
Note: Before installing verify that the steps in Prerequisite Software for 
OUASA Dashboard Component are followed.
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To install the OUASA Dashboard Package, follow these steps. 

1. Change to the <TEMPDIR>/OUBI.V2.4.0 directory.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer.

3. Execute the following script:

For UNIX:

export ORACLE_CLIENT_HOME=<oracle_client_home>

export PERL_HOME=$ORACLE_CLIENT_HOME/perl

export PATH=$PATH:$PERL_HOME/bin

ksh ./install_OUBI.sh

For Windows:

set ORACLE_CLIENT_HOME=<oracle_client_home>

set  PERL_HOME=%ORACLE_CLIENT_HOME%\perl

set  PATH=%PERL_HOME%\bin;%PATH%

Install_OUBI.cmd

Note: On UNIX, ensure that you have the proper execute permission on 
install_OUBI.sh.

4. The Oracle Utilities Advanced Spatial and Operational Analytics specific menu appears.

5. Under the Installation Options, enter “OBIEE”.

6. Select each menu item to configure the values. For detailed description of the values, see 
Configuration Worksheet for Dashboard Component Installation.

************************************

* Environment Installation Options *

************************************

1.
       Oracle Client Home Directory:                      
       Installation Options:                              
2.
       Environment Mount Point:                           
       Log Files Mount Point:                             
       Environment Name:                                  
       Web Java Home Directory:                           
       Database Home Directory:                           
       Database Type:                                     oracle

Each item in the above list should be configured for a successful 
install.

Choose option (1,2, <P> Process, <X> Exit):

In the environment configuration describes below, only 1 and 2 menu items are required to be 
configured. For detailed description of the values, see Configuration Worksheet for Dashboard 
Component Installation.

*****************************

* Environment Configuration *
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*****************************

1. Environment Description
       Environment Description:

2. OBIEE Environment Configuration
       Oracle BI Instance Home:
       Oracle BI Home:
       Oracle BI Domain Home:
       Weblogic Domain Console User Name:
       Weblogic Domain Console Host:
       Weblogic Domain Console Port Number:

3. Database Configuration

4. DESIGN REPOSITORY CONFIGURATION

5. DATABASE CHARACTER SET CONFIGURATION

6. EDITING PROCESS FLOW CONFIGURATION

7. EMAIL CONFIGURATION

8. CONTROL CENTRE CONFIGURATION

9. EXTERNAL DATA SOURCE CONFIGURATION
       Path of the External Datasource LOG:

Each item in the above list should be configured for a successful 
install.

Choose option (1,2,3,4,5,6,7,8,9, <P> Process, <X> Exit):

When you are done with the parameter setup, proceed with the option P. Write the configuration 
file. Once the installation is completed successfully, you will need to execute post-installation steps 
as described in Post-installation Tasks.

Post-installation Tasks
The following post-installation tasks are discussed in this section:

• Deploying Repository (RPD) File

• Deploying Web Catalog

• Configuring and Deploying MapViewer

• Modifying instanceconfig.xml

• Deploying Custom MapViewer

• Deploying Write Back

• Deploying Analytics

• Enabling Analytics Help

Deploying Repository (RPD) File
The RPD file is located at: <install_dir>/Reports/rpd/UtilitiesBusinessAnalytics240.rpd, where 
<install_dir> is the OUASA dashboard package installation directory.

To deploy the repository (RPD) file, follow these steps:

1. OBIEE 11.1.1.5.0 should have been installed on Windows 32-bit machine before proceeding 
with the steps below.
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2. Launch the Administration Tool from your Start menu from the Windows machine. This is 
only available in Windows.

Start > Programs > Oracle Business Intelligence > Administration.

3. Open the RPD in offline mode by selecting File > Open > Offline...

4. Provide the RPD password. For example, “oracle123”.

5. Edit the connection pools shown below by double clicking on them.

6. In the Init Block Connection Pool group, enter the following:

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

7. In the Init Block Pool - MDM group, provide the following, only for MDM:

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

8. In the MDM Database Connection group, provide the following, only for MDM:

Data source name = MDM database name

User name = CISUSER

Password = CISUSER User password

9. In the ODIDEV Connection Pool group, provide the following:

Data source name = BI database name

User name = DWUSER
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Password = DWUSER User password

10. In the OUBI Database Connection group, provide the following:

Data source name = BI database name

User name = DWREAD

Password = DWREAD User password

11. Click Save.

12. Login into OBIEE Enterprise Manager.

13. Navigate to BI Instance > Coreapplication > Deployment.

14. Lock and edit.

The repository text box will be enabled.

15. Browse to the modified rpd file and submit. The file is in the following location, where 
<install_dir> is the OUASA dashboard package installation directory.

<Install_Dir>/Reports/rpd/UtilitiesBusinessAnalytics240.rpd

16. Provide the RPD password “oracle123” click Apply.

17. Activate the changes and then restart the BI Services.

Note: All the above databases set in the connection pool should be updated in 
tnsnames.ora file in <OBIEE_INSTALL_DIR>/Oracle_BI1/network/
admin.

Deploying Web Catalog
To deploy the Web catalog, follow these steps:

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.
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Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

ksh ./deploycatalog.sh

Enter the location of the physical catalogs configured in Enterprise Manager. For 
example:

<OBIEE_INSTALL_DIR>/instances/instance1/bifoundation/ 
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/
SampleAppLite

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%/bin

deploycatalog.cmd

Enter the location of the physical catalogs configured in Enterprise Manager. For 
example:

<OBIEE_INSTALL_DIR>/instances/instance1/bifoundation/ 
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/
SampleAppLite

Configuring and Deploying MapViewer
To configure and deploy MapViewer, follow these steps:

• Configure MapViewer

• Modify instanceconfig.xml

• Deploy Custom MapViewer

Configuring MapViewer - 

To configure MapViewer, follow these steps:

1. Login to WebLogic console.

2. In the WebLogic console, create the 'MAP_DS' data source.

3. Lock and edit.

4. Navigate to Services < Data Sources.

5. Select New > Generic Data Source and provide the following details:

Name = MAP_DS

JNDI Name = MAP_DS

Database Type = oracle

6. Click Next.

7. Enter the following:

Database Driver = XA thin database driver

8. Click Next.

9. Enter the following Connection properties:

Database Name:BI Database Name
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Host Name:Database host

Port:Database port

Database User Name:dwadm

Password:dwadm password

10. Click Next and then click Finish.

11. Click Activate Changes.

12. Update the mapViewerConfig file with below mentioned tags:

File location : < OBIEE_INSTALL_DIR >/Oracle_BI1/bifoundation/jee/
mapviewer.ear/

web.war/WEB-INF/conf/

File: mapViewerConfig.xml

13. If there is proxy used, insert the list of host names for all the third party service providers in 
the security_config node.

<proxy_enabled_hosts>

elocation.oracle.com,maps.weatherbug.com,direct.weatherbug.com,api.wxbug.n

et,de.tiles.weatherbug.com

</proxy_enabled_hosts>

14. Update the following ns_data_provider node:

<ns_data_providerid="obieeNsdp"

class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

15. Update the current map_tile_server with the following map_tile_server node.

<map_tile_server>

<tile_storage default_root_path="/mytilecache/"/>

</map_tile_server>

16. Update the instance config file location, for example: FileLocation:

For UNIX:

<OBIEE_INSTALL_DIR>/instances/instance1/config/
OracleBIPresentationServicesComponent/coreapplication_obips1

For Windows:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesCo
mponent\coreapplication_obips1

Modifying instanceconfig.xml
Update the security node with the following values. If the security Node is not present, add the 
following code before </Serverinstance>:

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>

Deploying Custom MapViewer
To deploy the custom MapViewer, follow these steps:
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For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

ksh ./deploymapviewer.sh

Enter the WebLogic Domain Console password. For example, weblogic123

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%\bin

deploymapviewer.cmd

Enter the WebLogic Domain Console password. For example, weblogic123

Perform the following steps after deploying the custom MapViewer:

1. Update MapViewer configuration by navigating to MapViewer > Administration >

Configuration.

2. Add the below content in the mapViewerConfig.xml with appropriate parameters.

<DB_HOST>,<DBNAME>,<DB_PORT>,<USER>,<PASSWORD>

<map_data_source name="MAPCONN"

jdbc_host="<DB_HOST>"

jdbc_sid="<BI Database Name>"

jdbc_port="<DB_PORT>"

jdbc_user="<DWADM>"

jdbc_password="<DWADM PASSWORD>"

jdbc_mode="thin"

number_of_mappers="32"

allow_jdbc_theme_based_foi="true"

/>

3. Save and then restart.

Note: The above step has to be performed each time after running the 
deploymapviewer command.

Deploying Write Back
The purpose of the write back templates enable the user to allow and configure Administrative 
dashboards. This is mandatory for the Admin dashboard functionality to work.

To deploy the write back feature, follow these steps:

1. Open the following file:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesCo
mponent\

coreapplication_obips\instanceconfig.xml

2. Update the following <ServerInstance> element:
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<LightWriteback>true</LightWriteback>

3. Deploy write back as follows:

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

ksh ./deploywriteback.sh

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%/bin

deploywriteback.cmd

Deploying Analytics
To deploy the analytics, follow these steps:

1. Edit the Presentation Services configuration file, "instanceconfig.xml", in the following 
directory:

<OBIEE_INSTALL_DIR>/instances/instance1/config/
OracleBIPresentationServicesComponent/

coreapplication_obips1

2. Add the following before the end tag </ServerInstance>:

<UI>

<DefaultStyle>oubi</DefaultStyle>

<DefaultSkin>oubi</DefaultSkin>

</UI>

Enabling Analytics Help
To enable the Analytics' help, follow these steps:

1. Download the Oracle Utilities Advanced Spatial and Operational Analytics User Guide from 
Oracle Software Delivery Cloud.

2. After downloading the OUASA User Guide, change the name of the Help file to OUASA 
Help.pdf.  
Now, place the Help file in <install_dir>/Skin/res, where <install_dir> is the OUASA 
dashboard package installation directory.

3. Run the following commands:

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

ksh ./deployanalyticsear.sh

Enter the WebLogic Domain Console Password. For example, weblogic123

For Windows:
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Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%/bin

deployanalyticsear.cmd

Enter the WebLogic Domain Console Password. For example, weblogic123

4. Restart the BI Core services.

5. Restart WebLogic and all BI services after the OBIEE deployment is completed.

6. Log in to Analytics and navigate to Administration > Manage Privileges > Write Back > 
Write Back to Database. 

7. Click Denied:Authenticated User and select Granted.

After the Installation
Ensure that the following tasks are performed after installing Oracle Utilities Advanced Spatial 
and Operational Analytics:

1. For  OUASA ETL related post-installation tasks, see OUASA ETL Component 
Installation.

2. For OUASA dashboard related post-installation tasks, see OUASA Dashboard Component 
Installation.

3. For configuring the mapping and other parameters, refer to the Oracle Utilities Advanced Spatial 
and Operational Analytics Administration Guide.

4. Start File Processor Daemon.

5. Verify install and deploy logs:

<INSTALL_DIR>/OWB/MetadataFiles/SPL-BI-Project_imp.log 

<INSTALL_DIR>/OWB/MetadataFiles/SPL-BI-Location_imp.log

OWB deploy logs:

<INSTALL_DIR>/logs/system/log_OWBDeployment_YYYYMMDD_####.txt 

Custom Mapviewer deploy logs:

<INSTALL_DIR>/logs/system/mapviewerdeploy.sh.log

WriteBack logs:

<INSTALL_DIR>/logs/system/Writeback.log

FileProcessorDaemon logs:

<INSTALL_DIR>/bin/FileProcessorDaemon.log

6. Log into the OBIEE analytics link pointing to the demo database. The dashboard should 
display data with no errors.
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Chapter 6 
Upgrading to Oracle Utilities Advanced Spatial 

and Operational Analytics v2.4.0

This chapter provides instructions for upgrading to Oracle Utilities Advanced Spatial and 
Operational Analytics v2.4.0. 

The chapter includes the following topics: 

• Before You Install

• Supported Upgrade Paths

• Upgrade

• After the Installation

Before You Install
Refer to article 1391459.1 on My Oracle Support (https://support.oracle.com/) for latest updated 
information on Oracle Utilities Advanced Spatial and Operational Analytics installation.

Supported Upgrade Paths
Direct upgrade to Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 is supported 
from the following versions:

• Oracle Utilities Advanced Spatial and Operational Analytics v2.3.2.1

For upgrading from a version not supported by direct upgrade path, the product should first be 
upgraded to v2.3.2.1 and then upgraded to v2.4.0.

Upgrade
This section describes the procedure to upgrade Oracle Utilities Advanced Spatial and 
Operational Analytics v2.3.2.1 to v2.4.0.

• OUASA Database Component Upgrade

• OUASA ETL Component Upgrade

• OUASA Dashboard Component Upgrade

OUASA Database Component Upgrade
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This section describes the upgrade installation of the database. Upgrade the database to 
AL32UTF8 character set. Following topics are discussed in this section: 

• Copying and Decompressing Install Media

• DWADM Schema Upgrade

• Security Configuration

• Spatial Configuration

• Generating Database Statistics

Copying and Decompressing Install Media
To copy and then decompress the install media, follow these steps:

1. Download the Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Oracle 
Database part from Oracle Software Delivery Cloud. 

2. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp. (Referred to 
below as <TEMPDIR>.) This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation.

3. Copy the file OUASA-V2.4.0-Database-Multiplatform.zip from the delivered package to the 
<TEMPDIR>.

4. Unzip the zip file using any zip utility.

DWADM Schema Upgrade
This section describes how to upgrade an existing v2.3.2.1 target schema to v2.4.0. The upgrade 
process prompts you for the names of three database users:

• A user that will own the application schema. For example, DWADM

• A user that has read-write (select/update/insert/delete) privileges to the objects in the 
application schema. The application will access the database as this user. For example, 
DWUSER

• A user with read-only privileges to the objects in the application schema. For example, 
DWREAD

The upgrade process also prompts you for the following:

• A database role that has read-write (select/update/insert/delete) privileges to the objects in 
the application schema. The application will access the database as this user. For example, 
DW_USER

• A database role with read-only privileges to the objects in the application schema. For 
example, DW_READ

• Location for jar files. (The Jar files are bundled with the database package.)

• Java Home. For example, C:\Java\jdk1.6.0_18

To upgrade the Oracle database, perform the following steps:

Note: Ensure to run CDXDBI.exe from a Window 32-bit desktop that has the 
Oracle 11.2.0.2 client and Java Development Kit Version 6.0 Update 20 or later.

Upgrade your database to AL32UTF8 character set.

1. Run CDXDBI.exe from ..\BI240\DWADM\Install-Upgrade. Please run this utility from 
command prompt. The utility prompts you to enter values for the following parameters:

Name of the target database.:<DB NAME>
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Password for the SYSTEM user account in the database (in silent mode)

Name of the owner of the Database Schema:<DWADM>

Location of Java Home: <..\jdk1.6.0_20>

Location of TUGBU Jar files: <..\BI240\DWADM\Jarfiles>

Password for the user (in silent mode)

Oracle user with read-write privileges to the Database Schema:<DWUSER>

Oracle user with read-only privileges to the Database Schema:<DWREAD>

Oracle database role with read-write privileges to the Database Schema:<DW_USER>

Oracle database role with read-only privileges to the Database Schema:<DW_READ>

2. If you chose to continue, CDXDBI first checks for the existence of each of the users 
specified and prompts for their password, default tablespace, and temporary tablespace, if 
they do not exist.

3. After setting up roles and users, the utility continues upgrading schema and system data 
definitions. If an error occurs while executing an SQL or another utility, it logs and displays 
the error message and allows you to re-execute the current step.

4. Navigate to BI240/DWADM/Post-Upgrade folder and execute 
FieldMetadata_FeatureConfigMigrationScript.sql:

- sqlplus dwadm/dwadm@database-name 
@FieldMetadata_FeatureConfigMigrationScript.sql

5. Enter SPLADM at the following prompt:

Enter Application Schema Owner Name:(e.g SPLADM)

6. Connect to DWADM schema and execute the following sql:

update b1_configuration set override_value = ''
where feature_name = 'B1_MAPATTPRO' and option_code = 'B1DD';
Commit;

Security Configuration
The configuration utility and scripts are located in the Security folder.

To request grants for the DWADM schema, follow these steps:

1. Navigate to the ..\BI240\/DWADM\/Security folder.

2. Edit the file DWADM-OraGenSec.bat, which is in the same location, and replace the 
parameter database-name with the name of your database. This file is provided for your 
convenience and executes the Oragensec.exe utility based on the parameters passed into it.

Note: Ensure to run DWADM-OraGenSec.bat from a Window 32-bit desktop 
that has the Oracle 11.2.0.2 client installed. Your database should already be 
listed in the local file tnsnames.ora. The script executes as follows: 

oragensec -d DWADM,DWADM,database_name -r DW_READ,DW_USER -a A -u
SPLUSER,SPLREAD

3. Execute the edited DWADM-OraGenSec.bat file from command prompt. This utility 
configures the security for DWADM schema objects.

Spatial Configuration 
Note: See Spatial Configuration to configure spatial data if application has 
not been yet configured.
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If spatial data is already configured in application please follow the steps below: This section 
describes how to load spatial metadata in USER_SDO* tables for Oracle Utilities Advanced 
Spatial and Operational Analytics.

Use the following procedure to load spatial metadata in the target database:

1. Create the dump_dir directory in database and copy user_sdo.dmp file from ../B1240/
Spatial-Metadata folder to that location.

2. Import released spatial tables to the target database using following command:

impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=

imp_user_sdo.log schemas=DWADM

Note: Run this command from database server.

3. Review the imp_user_sdo.log file to ensure the tables were imported successfully.

4. After importing the tables, run following SQL scripts from the ../B1240/Spatial-Metadata 
folder:

- sqlplus dwadm/dwadm@database-name @copy_spatial_metadata.sql

- sqlplus dwadm/dwadm@database-name @clean_sdo_release_tbls.sql

5. Review the log files.

Generating Database Statistics
During an install process, new database objects may be added to the target database. Before 
starting to use the database, generate the statistics for these new objects.

OUASA ETL Component Upgrade
This section describes the ETL component installation.

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• Configuring Oracle Warehouse Builder Workspace

• OUASA ETL Package Upgrade Steps

• Post-upgrade Tasks

Copying and Decompressing Install Media
The Oracle Utilities Advanced Spatial and Operational Analytics application server installation file 
is delivered in jar format for both UNIX and Windows platforms. If you plan to install multiple 
Oracle Utilities Advanced Spatial and Operational Analytics environments operated by different 
Oracle Utilities Administrator user IDs, you must complete each of the following installation steps 
for each Administrator user ID.

1. Log in to the database server host as the Oracle Utilities Advanced Spatial and Operational 
Analytics administrator user ID (default cases).

2. Create a temporary directory such as c:\OUASA\temp or /OUASA/temp. (Referred to 
below as <TEMPDIR>.) This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation.

3. Copy the file OUASA.V2.4.0-MultiPlatform.jar from the delivered package to the 
<TEMPDIR>. If you are using FTP to transfer this file, remember to use the BINARY 
option for the FTP transfer.

4. Decompress the file:
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cd <TEMPDIR>

jar -xvf OUASA.V2.4.0-MultiPlatform.jar

Note: You will need to have Java JDK installed on the machine used to (un)jar 
the application server installation package. Install the JDK that is supported for 
the install on your platform to be able to use the jar command.

The Java packages are located at: http://java.sun.com/products/archive/index.html.

A sub-directory named "OUBI.V2.4.0" is created. It contains the installation software for the 
Oracle Utilities Business Intelligence application server.

Setting Permissions for cistab File in UNIX
Every Oracle Utilities Advanced Spatial and Operational Analytics environment installed on a 
server must be registered in the /etc/cistab file located on that server. On UNIX servers, generally 
only the root user ID has write permissions to the /etc directory. Since the installation process is 
run by the Oracle administrator user ID (cissys), this user ID may not be able to write to /etc/
cistab table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/OUBI.V2.4.0 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Advanced Spatial and Operational Analytics application environment on the 
server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Advanced 
Spatial and Operational Analytics administrator user ID, so that the next time a new environment 
is created by the same Oracle Utilities Advanced Spatial and Operational Analytics administrator 
user ID, you do not need to run the generated script with the root user ID. Instead the install 
utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you are planning to upgrade an existing environment it is your responsibility to take a backup 
prior to the installation process. The installation utility does not create a backup of existing 
environment.

Configuring Oracle Warehouse Builder Workspace
This section describes the procedure to configure Oracle Warehouse Builder workspace.

To upgrade Oracle Utilities Advanced Spatial and Operational Analytics v2.3.2.1 to v2.4.0, follow 
these steps:

1. Back up the database using the backup strategy employed at your site.

2. Apply 12874883 OWB patch to database server and OWB client if already not applied.

3. Connect to BIREPOWN user and run spl_exec_wf_prc.sql.

spl_exec_wf_prc.sql is located at ../BI240/Scripts.

4. Connect to the DWADM schema and execute spl_oms_snapshot_pkg.sql.

spl_oms_snapshot_pkg.sql is located at ../BI240/Scripts.

5. Connect to the database with sys user and execute the following SQL statements:

DROP SYNONYM DWADM.WB_RT_AUDIT;

CREATE SYNONYM DWADM.WB_RT_AUDIT FOR OWBSYS.WB_RT_AUDIT;

GRANT SELECT ON OWBSYS.WB_RT_AUDIT TO DWADM;
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GRANT SELECT ON OWBSYS.ALL_RT_AUDIT_EXECUTIONS TO DWADM;

GRANT ALL ON OWBSYS.WB_RT_AUDIT_PURGE TO DWADM;

GRANT ALL ON OWFMGR.WF_PURGE TO DWADM;

GRANT SELECT_CATALOG_ROLE TO BIREPOWN;

GRANT ALL ON OWBSYS.WB_RT_AUDIT_EXECUTIONS TO DWADM;

GRANT ALL ON OWBSYS.WB_RT_DEF_EXECUTION_OPERATORS TO 
DWADM;

DROP SYNONYM DWADM.WB_RT_AUDIT_EXECUTIONS;

DROP SYNONYM DWADM.WB_RT_DEF_EXECUTION_OPERATORS;

CREATE SYNONYM DWADM.WB_RT_AUDIT_EXECUTIONS FOR

OWBSYS.WB_RT_AUDIT_EXECUTIONS;

CREATE SYNONYM DWADM.WB_RT_DEF_EXECUTION_OPERATORS FOR

OWBSYS.WB_RT_DEF_EXECUTION_OPERATORS;

alter system set query_rewrite_enabled=force;

alter system set query_rewrite_integrity=trusted;

OUASA ETL Package Upgrade Steps
Follow these steps to upgrade the OUASA package applications after the above steps are 
performed to deploy the ETL component objects:

1. Change to the <TEMPDIR>/OUBI.V2.4.0 directory.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer.

3. Oracle Database Enterprise Edition 11.2.0.2 Installed User should be having privilege to 
install OUASA Package.

4. Execute the following script:

For UNIX:

export ORACLE_CLIENT_HOME=<oracle_client_home>

export PERL_HOME=$ORACLE_CLIENT_HOME/perl

export PATH=$PATH:$PERL_HOME/bin

ksh ./install_OUBI.sh

For Windows:

set ORACLE_CLIENT_HOME=<oracle_client_home>

set PERL_HOME=%ORACLE_CLIENT_HOME%\perl

set PATH=%PERL_HOME%\bin;%PATH%

Install_OUBI.cmd

Note: On UNIX, ensure that you have the proper execute permission on 
install.sh.

5. The Oracle Utilities Advanced Spatial and Operational Analytics specific menu will appear.

6. Under the Installation Options, enter “OWB”.

7. Select the Each Menu Item to configure the values. For detailed description of the values 
see Configuration Worksheet for ETL Component Installation.
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************************************

* Environment Installation Options *

************************************

1.

       Oracle Client Home Directory:                      

       Installation Options:                              

2.

       Environment Mount Point:                           

       Log Files Mount Point:                             

       Environment Name:                                  

       Web Java Home Directory:                           

       Database Home Directory:                           

       Database Type:                                     oracle

Each item in the above list should be configured for a successful install.

Choose option (1,2, <P> Process, <X> Exit):

*****************************

* Environment Configuration *

*****************************

1. Environment Description

       Environment Description:                           

2. OBIEE Environment Configuration

3. Database Configuration

       OWB WorkSpace Owner:                              

       OWB WorkSpace Owner Password:                      

       Database Name:                                     

       Database Server:                                   

       Database Port:                                     

4. DESIGN REPOSITORY CONFIGURATION

       OWB WorkSpace User:                                

       OWB Workspace user Password:                       

       OWB WorkSpace Name:                                

       DWADM SCHEMA NAME:                                 
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       DWADM SCHEMA Password:                             

       WORKFLOW MANAGER SCHEMA NAME:                      

       WORKFLOW MANAGER SCHEMA Password:                 

5. DATABASE CHARACTER SET CONFIGURATION

       Database Character set:                            AL32UTF8

6. EDITING PROCESS FLOW CONFIGURATION

       Repository Operating System:                       

       Perl Compiler location:                            

       Data and control files location:                   

       Separator to be used:                              

       File Manager location:                             

7. EMAIL CONFIGURATION

       Email ID of Sender:                                

       Email ID for Reply-To address:                     

       Email ID of Receiver:                              

       SMTP server:                                       

       SMTP server port:                                  

8. CONTROL CENTRE CONFIGURATION

       Repository Control Center Name:                    

9. EXTERNAL DATA SOURCE CONFIGURATION

       Path of the External Datasource:                   

       Path of the External Datasource LOG:               

       File Processor Daemon Execution Switch:            1

       File Processor Extract Max Load:                         5

       File Processor Scheduler Poll Duration:            60

Each item in the above list should be configured for a successful install.

Choose option (1,2,3,4,5,6,7,8,9, <P> Process, <X> Exit):

8. When you are done with the parameter setup, proceed with the option P. Write Configure file.

9. Once the install has finished successfully, you will need to execute post-upgrade steps as 
described in Post-upgrade Tasks.

Post-upgrade Tasks
Following topics are discussed in this section: 
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• Deploying ETL Workflows on Oracle Warehouse Builder

Deploying ETL Workflows on Oracle Warehouse Builder
In UNIX, you may get a Java heap space error while importing the MDL file. To resolve this error 
you may need to make change in OMBPlus.sh file, located at: $ORACLE_HOME/owb/bin/
unix/OMBPlus.sh.

In the following code, change the value -Xmx768M to -Xmx1024M, and then the -Dlimit value 
768M to 1024M.

$JAVAPATH/bin/java $JAVA64FLAG -Xms64M -Xmx768M $OPTS -Dlimit=768M -
DORACLE_HOME=$ORACLE_HOME -DOWBCC_HOME=$ORACLE_HOME -
DTCLLIBPATH="$TCLLIBPATH" -
DMARATHON_RETRY_COUNT="$MARATHON_RETRY_COUNT" -
DMARATHON_RETRY_INTERVAL="$MARATHON_RETRY_INTERVAL" 
$CLASSPATH_LAUNCHER oracle.owb.scripting.OMBShell $*

You may need to make this value larger than 1024MB (1GB) depending on the size of the import.

Perform the following tasks:

• Deploying OWB Workflows

• Deploying Materialized Views

• Generating Security

• Generating Database Statistics

Deploying OWB Workflows
This step needs to be performed if changes have been made to the parallel settings on external 
tables, materialized views or mappings on an existing installation and needs to be retained during 
the upgrade process.

Run the following command to generate a report on the parallel settings that is currently set in the 
customer repository on external tables, materialized views and mappings.

For UNIX:

Initialize the environment by executing the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

ksh ./parallelSetup.sh analyze

For Windows:

Initialize the environment by executing the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%\bin

parallelSetup.cmd analyze

This will generate the following files under <SPLEBASE>/etc folder:

cm-parallel-tables.txt

cm-parallel-mvs.txt

cm-parallel-maps.txt

Review the above files for existing settings and make modifications if necessary. Once the files are 
reviewed perform the following step to merge the existing settings with the default settings.
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For UNIX:

Initialize the environment by executing the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

ksh ./parallelSetup.sh merge

For Windows:

Initialize the environment by executing the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%\bin

parallelSetup.cmd merge

Review the following files under <SPLEBASE>/etc and verify that the existing values have been 
merged correctly before proceeding:

parallel-tables.txt

parallel-mvs.txt

parallel-maps.txt

Below is the format of parallel*.txt to change the <Degree> of parallelism in above listed files.

parallel-tables.txt file format: <Object_name>:<Degree>

parallel-mvs.txt file format: <MV_Name>:<Fact_Table>:<Degree>

parallel-maps.txt file format: <Object_name>:<Table_Name>:<Degree>

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command. 

Note: Navigate to the Install_Dir/bin to initialize. 

cd $SPLEBASE/bin

Run Ksh ./Owbdeploy.sh

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%\bin

Run Owbdeploy.cmd

Deploying Materialized Views
Run the following commands for deploying Materialized Views.

For UNIX:

Initialize the environment by executing the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

Run ksh ./upgradeViews.sh
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For Windows:

Initialize the environment by executing the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%\bin

Run upgradeViews.cmd

Once the deployment is completed, remove the $SPLEBASE/tmp content to ensure all the 
complete files are removed.

cd $SPLEBASE/tmp

Generating Security
Edit database-name with the name of your database in OraGenSec.bat after completing the OWB 
deployment and run it from BI240/DWADM/Security folder.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
starting to use the database, generate the statistics for these new objects.

OUASA Dashboard Component Upgrade
This section describes the dashboard component installation.

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• OUASA Dashboard Package Upgrade Steps

• Upgrading RPD and Catalog Files

• Post-upgrade Tasks

Copying and Decompressing Install Media
The Oracle Utilities Advanced Spatial and Operational Analytics application server installation file 
is delivered in jar format for both UNIX and Windows platforms. If you plan to install multiple 
Oracle Utilities Advanced Spatial and Operational Analytics environments operated by different 
Oracle Utilities Administrator user IDs, you must complete each of the following installation steps 
for each Administrator user ID.

1. Log in to the application server host (where OBIEE 11.1.1.5.0 software is installed) as the 
Oracle Utilities Advanced Spatial and Operational Analytics administrator user ID (default 
ceases).

2. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp. (Referred to 
below as <TEMPDIR>.) This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation.

3. Copy the file OUASA.V2.4.0-MultiPlatform.jar from the delivered package to the 
<TEMPDIR>. If you are using FTP to transfer this file, remember to use the BINARY 
option for the FTP transfer.

4. Decompress the file:

cd <TEMPDIR>

jar -xvf OUASA.V2.4.0-MultiPlatform.jar
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Note: You will need to have Java JDK installed on the machine used to (un)jar 
the application server installation package. Install the JDK that is supported for 
the install on your platform to be able to use the jar command.

The Java packages are located at: http://java.sun.com/products/archive/index.html.

A sub-directory named "OUBI.V2.4.0" is created. It contains the installation software for the 
Oracle Utilities Business Intelligence application server.

Setting Permissions for cistab File in UNIX
Every Oracle Utilities Advanced Spatial and Operational Analytics environment installed on a 
server must be registered in the /etc/cistab file located on that server. On UNIX servers, generally 
only the root user ID has write permissions to the /etc directory. Since the installation process is 
run by the Oracle administrator user ID (cissys), this user ID may not be able to write to /etc/
cistab table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/OUBI.V2.4.0 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Advanced Spatial and Operational Analytics application environment on the 
server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Advanced 
Spatial and Operational Analytics administrator user ID, so that the next time a new environment 
is created by the same Oracle Utilities Advanced Spatial and Operational Analytics administrator 
user ID, you do not need to run the generated script with the root user ID. Instead, the install 
utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you plan to upgrade an existing environment it is your responsibility to take a backup prior to 
the installation process. The installation utility does not create a backup of existing environment.

OUASA Dashboard Package Upgrade Steps
Before upgrading verify that the steps in Prerequisite Software for OUASA Dashboard 
Component are followed.

To upgrade the OUASA dashboard package, follow these steps. 

1. Change to the <TEMPDIR>/OUBI.V2.4.0 directory.

2. Execute the following script:

For UNIX:

export ORACLE_CLIENT_HOME=<oracle_client_home>

export PERL_HOME=$ORACLE_CLIENT_HOME/perl

export PATH=$PATH:$PERL_HOME/bin

ksh ./install_OUBI.sh

For Windows:

set ORACLE_CLIENT_HOME=<oracle_client_home>

set PERL_HOME=%ORACLE_CLIENT_HOME%\perl

set PATH=%PERL_HOME%\bin;%PATH%Install_OUBI.cmd

Note: On UNIX, ensure that you have the proper execute permission on 
install.sh.
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3. The Oracle Utilities Advanced Spatial and Operational Analytics specific menu appears.

4. Under the Installation Options, enter “OBIEE”.

5. Select the Each Menu Item to configure the values. For detailed description of the values 
see Configuration Worksheet for Dashboard Component Installation.

************************************

* Environment Installation Options *

************************************

1.

      Oracle Client Home Directory:                      

       Installation Options:                              

2.

       Environment Mount Point:                           

       Log Files Mount Point:                             

       Environment Name:                                  

       Web Java Home Directory:                           

       Database Home Directory:                           

       Database Type:                                     oracle

Each item in the above list should be configured for a successful install.

Choose option (1,2, <P> Process, <X> Exit):

6. In the Environment Configuration worksheet mentioned below, only menu items 1 and 2 are 
required to be configured. For detailed description of the values see Configuration 
Worksheet for Dashboard Component Installation.

*****************************

* Environment Configuration *

*****************************

1. Environment Description

       Environment Description:

2. OBIEE Environment Configuration

       Oracle BI Instance Home:

       Oracle BI Home:

       Oracle BI Domain Home:

       Weblogic Domain Console User Name:

       Weblogic Domain Console Host:

       Weblogic Domain Console Port Number:

3. Database Configuration
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4. DESIGN REPOSITORY CONFIGURATION

5. DATABASE CHARACTER SET CONFIGURATION

6. EDITING PROCESS FLOW CONFIGURATION

7. EMAIL CONFIGURATION

8. CONTROL CENTRE CONFIGURATION

9. EXTERNAL DATA SOURCE CONFIGURATION

       Path of the External Datasource LOG:

Each item in the above list should be configured for a successful install.

Choose option (1,2,3,4,5,6,7,8,9, <P> Process, <X> Exit):

7. When you are done with the parameter setup, proceed with the option P. Write the Configure 
file.

8. Once the install has finished successfully, you will need to execute post-installation steps as 
described in Upgrading RPD and Catalog Files.

Upgrading RPD and Catalog Files
If you have made custom changes to OBIEE 10g RPD and catalog files, follow the procedures in 
this section to make those files compatible with 11g. This section includes the following topics:

• Converting RPD Files

• Converting Catalogs

• Merging the RPD Files

Converting RPD Files
Follow these steps to convert 10g RPD files to 11g:

1. Create a folder on the server where 11g OBIEE is installed. Copy the 10g RPD file that is 
deployed in your environment to this folder.

2. Go to $ORACLE_BI_HOME/bin and run ua.bat or ua.

3. Click Next to continue.

4. Select Upgrade Oracle BI RPD and Presentation Catalog.

5. Click Next to continue.

6. Select Upgrade repository.

7. Select the 10g RPD file contained in the folder that you created in step 1.

8. Enter the administrator User ID and password for the 10g RPD file.

9. Enter the new administrator password for 11g RPD, for example, oracle123.

10. Specify the WebLogic port and login details.

An 11g compatible rpd file will be created in the following location:

$ORACLE_INSTANCE /bifoundation/OracleBIServerComponent/
coreapplication_obis1/repository location.

11. Back up the converted rpd file from the deployed location. This is your changed rpd file.

Converting Catalogs
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Follow these steps to convert 10g catalog files to 11g:

1. Create a folder on the server where 11g OBIEE is installed. For example, obiee/
SampleAppLite.

2. Copy the contents of 10g ../../web/catalog/samplesales folder to the obiee/
SampleAppLitefolder.  The samplesales folder is included in the 10g application.

3. Create a folder named "deliveries" inside the OBIEE folder.

4. Navigate to $ORACLE_BI_HOME/bin and run ua.bat or ua.

5. Select Upgrade Oracle BI RPD and Web Catalog.

6. Click Next to continue.

7. Select Upgrade catalog.

8. Select the obiee/SampleAppLite folder as the catalog directory.

9. Select obiee/deliveries as the catalog deliveries directory.

10. Click Next.

11. Specify the WebLogic port and login details.

12. Click Next.

13. Click Upgrade.

The 10g catalogs will be deployed at the following location:

$ORACLE_INSTANCE/bifoundation/OracleBIPresentationServicesComponent/
coreapplication_obips1/catalog/SampleAppLite/root/shared location

Merging the RPD Files
Convert your 10g 2.3.2.1 original RPD file to 11g as described in Converting RPD Files on page 
4-14. The backup of the converted RPD should be considered the original RPD.

After you have converted the RPD file, follow these steps to merge the BI 2.4 RPD file, the 
original BI 2.3.2.1 RPD file, and the changed BI 2.3.2.1 RPD file. You will use the resulting 
merged RPD file for deployment in the OBIEE 11g instance.

1. In the OBIEE Administration Tool, open the Current Repository (2.4 Release RPD).

2. From the File menu, select Merge.

3. Select Original repository (2.3.2 Release RPD).
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4. Select Modified Repository as 2.3.2 (Customer Modified) RPD.

5. Define the merge strategy.

Defining Merge Strategy
The following examples show the results of some decision choices when the current and modified 
repositories are different:

• If the Description column for an object contains Added to Current, the following are choices 
in the Decision column and their results:

• Selecting Current keeps the addition in the current repository.

• Selecting Modified (D) deletes the added object from the current repository.

• If the Description column for an object contains Deleted from Modified, the following are 
choices in the Decision column and their results:

• Selecting Current keeps the repository as is without deleting the object.

• Selecting Modified (D) deletes the object from the current repository.

• If the Description column for an object contains Deleted from Current, the following are 
choices in the Decision column and their results:
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• Selecting Current keeps the repository as is without adding the object back into the 
current repository.

• Selecting Modified (A) adds the object back into the current repository.

• If the Description column for an object contains Added to Modified, the following are 
choices in the Decision column and their results:

• Selecting Current keeps the repository as is without adding the object back into the 
current repository.

• Modified (A). Selecting Modified (A) adds the object back into the current repository.

After the Merge, newly added functionality and old CM computed columns are intact.

After upgrading the RPD and catalog files, you will need to execute the post-upgrade steps as 
described in Post-upgrade Tasks.

Post-upgrade Tasks
Post-upgrade tasks involve the following: 

• Deploying the Repository (RPD) File

• Deploying Web Catalog

• Configuring and Deploying MapViewer

• Deploying Write Back

• Deploying Analytics

Deploying the Repository (RPD) File
The RPD file is in the following location: <install_dir>/Reports/rpd/
UtilitiesBusinessAnalytics240.rpd, where <install_dir> is the OUASA dashboard package 
installation directory.

Follow these steps to deploy the RPD file:
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1. OBIEE 11.1.1.5.0 should be installed on Windows 32-bit machine before proceeding with 
the below steps.

2. Launch the Administration Tool from your Start menu.

Start > Programs > Oracle Business Intelligence > Administration 

3. Open the RPD in offline mode by selecting File > Open > Offline...

4. Provide the RPD password. For example, “oracle123”.

5. Edit the connection pools shown below by double clicking on them.

6. In the Init Block Connection Pool group, enter the following:

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

7. In the Init Block Pool - MDM group, provide the following, only for MDM:

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

8. In the MDM Database Connection group, provide the following, only for MDM:

Data source name = MDM database name

User name = CISUSER

Password = CISUSER User password

9. In the ODIDEV Connection Pool group, provide the following:

Data source name = BI database name
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User name = DWUSER

Password = DWUSER User password

10. In the OUBI Database Connection group, provide the following:

Data source name = BI database name

User name = DWREAD

Password = DWREAD User password

11. Click Save.

12. Login into OBIEE Enterprise Manager.

13. Navigate to BI Instance > Coreapplication > Deployment.

14. Lock and edit.

The repository text box will be enabled.

15. Browse to the modified rpd file and submit. The file is in the following location, where 
<install_dir> is the OUASA dashboard package installation directory.

<Install_Dir>/Reports/rpd/UtilitiesBusinessAnalytics240.rpd

16. Provide the RPD password “oracle123”, and then click Apply.

17. Activate the changes and then restart the BI Services.

Note: All the above databases set in the connection pool should be updated in tnsnames.ora file in 
<OBIEE_INSTALL_DIR>/Oracle_BI1/network/admin.

Deploying Web Catalog
Note: You must delete the old BI v2.3.2.1 catalogs (if present in 11g OBIEE 
instance) before deploying the catalogs.
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The deployment procedure should be run on your Windows client/server machine that has the 
OBIEE 11.1.1.5 client installed.

To delete the old catalogs, follow these steps:

1. Launch the Catalog Manager from your Start menu.

Start > Programs > Oracle Business Intelligence > Catalog Manager

2. From the File menu, select Open Catalog. The Open Catalog window is displayed.

3. Specify the following values:

1. From the Type drop-down, select Online.

2. Enter the URL to the analytics Web application in the following form:

http://<OBIEE Host>: <OBIEE Port>/analytics/saw.dll

3. Enter Administrator as the User and ASAadm as the Password.

4. Click OK to close the window.

5. In the tree panel, expand the root folder /.

6. Select the Shared folder.

7. Select the catalogs in the shared folder, right click, and then select Delete.

It will prompt for Physical Catalog location configured in Enterprise Manager. This is the server 
path where OBIEE is installed.
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To deploy the catalogs, follow these steps:

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

ksh ./deploycatalog.sh

Enter the physical catalogs location configured in Enterprise Manager. For example:

<OBIEE_INSTALL_DIR>/instances/instance1/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/
SampleAppLite

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd  %SPLEBASE%\bin

deploycatalog.cmd

Enter the Physical Catalogs location configured in EM For example:

<OBIEE_INSTALL_DIR>/instances/instance1/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/
SampleAppLite

Configuring and Deploying MapViewer
Configuring and deploying the MapViewer involves the following:

Configuring MapViewer - To configure MapViewer, follow these steps:

1. Login to WebLogic console.

2. In the WebLogic console, create the 'MAP_DS' data source.

3. Lock and edit.

4. Navigate to Services < Data Sources.

5. Select New > Generic Data Source and provide the following:

Name = MAP_DS

JNDI Name = MAP_DS

Database Type = oracle

6. Click Next.

7. Enter the following:

Database Driver = XA thin database driver

8. Click Next.

9. Enter the following Connection properties:

Database Name:BI Database Name

Host Name:Database host

Port:Database port

Database User Name:dwadm
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Password:dwadm password

10. Click Next and then click Finish.

11. Click Activate Changes.

12. Update the mapViewerConfig file with below mentioned tags:

File location : <OBIEE_INSTALL_DIR>/Oracle_BI1/bifoundation/jee/
mapviewer.ear/web.war/WEB-INF/conf/

File: mapViewerConfig.xml

13. If there is proxy used, insert the list of host names for all the third party service providers in 
the security_config node.

<proxy_enabled_hosts>

elocation.oracle.com,maps.weatherbug.com,direct.weatherbug.com,api.wxbug.net,de.tiles.wea
therbug.com

</proxy_enabled_hosts>

14. Update the following ns_data_provider node:

<ns_data_providerid="obieeNsdp"

class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

15. Update the current map_tile_server with the following map_tile_server node.

<map_tile_server>

<tile_storage default_root_path="/mytilecache/"/>

</map_tile_server>

16. Update the instance config file location, for example:

FileLocation:

For Unix :

<OBIEE_INSTALL_DIR>/instances/instance1/config/
OracleBIPresentationServicesComponent/coreapplication_obips1

For Windows:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesCo
mponent\coreapplication_obips1

Modify instanceconfig.xml - Update the security Node with the following values. If the 
security Node is not present, add following code before </Serverinstance>:

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>

Deploying Custom MapViewer - To deploy the custom MapViewer, follow these steps:

For Unix:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.
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cd $SPLEBASE/bin

ksh ./deploymapviewer.sh

Enter the WebLogic Domain Console Password. For example, weblogic123

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%\bin

deploymapviewer.cmd

Enter WebLogic Domain Console Password. For example, weblogic123

Perform the following steps after deploying the custom MapViewer:

1. Update the MapViewer configuration by navigating to MapViewer > Administration > 
Configuration.

2. Add the below content in the mapViewerConfig.xml with appropriate values:

<DB_HOST>,<DBNAME>,<DB_PORT>,<USER>,<PASSWORD>

<map_data_source name="MAPCONN"

jdbc_host="<DB_HOST>"

jdbc_sid="<BI Database Name>"

jdbc_port="<DB_PORT>"

jdbc_user="<DWADM>"

jdbc_password="<!DWADM PASSWORD>"

jdbc_mode="thin"

number_of_mappers="32"

allow_jdbc_theme_based_foi="true"

/>

3. Save and then restart.

Note: The above step has to be performed each time after running the 
deploymapviewer command.

Deploying Write Back
Follow these steps to deploy the write back feature.

1. Open the following file:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesCo
mponent\coreapplication_obips\instanceconfig.xml

2. Update the following <ServerInstance> element according to the following code:

<LightWriteback>true</LightWriteback>

3. Deploy write back as follows:

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin
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ksh ./deploywriteback.sh

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%/bin

deploywriteback.cmd

Deploying Analytics
To deploy analytics, follow these steps:

1. Edit the Presentation Services configuration file, "instanceconfig.xml", in the following 
directory:

<OBIEE_INSTALL_DIR>/instances/instance1/config/
OracleBIPresentationServicesComponent/coreapplication_obips1

2. Add the following before the end tag </ServerInstance>

<UI>

<DefaultStyle>oubi</DefaultStyle>

<DefaultSkin>oubi</DefaultSkin>

</UI>

Enabling Analytics Help - To enable the analytics' help, follow these steps:

1. Download Oracle Utilities Advanced Spatial and Operational Analytics User Guide from Oracle 
Software Delivery Cloud.

2. After downloading the OUASA User Guide, change the name of the Help file to OUASA 
Help.pdf.  
Now, place the Help file in <install_dir>/Skin/res, where <install_dir> is the OUASA 
dashboard package installation directory.

3. Run the following commands:

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

ksh ./deployanalyticsear.sh

Enter the WebLogic Domain Console Password. For example, weblogic123

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%/bin

deployanalyticsear.cmd

Enter the WebLogic Domain Console Password. For example, weblogic123

4. Restart the BI Core services.

5. Restart WebLogic and all BI services after the OBIEE deployment is completed.
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6. Login to Analytics and navigate to Administration>Manage Privileges>Write 
Back>Write Back to Database. 

7. Click Denied:Authenticated User and select the permission Granted.

After the Installation 
After the installation, perform the following: 

1. Verify Install and Deploy Logs.

• MDL Import Logs

<INSTALL_DIR>/OWB/MetadataFiles/SPL-BI-Project_imp.log 

<INSTALL_DIR>/OWB/MetadataFiles/SPL-BI-Location_imp.log

• OWB Deploy Logs

<INSTALL_DIR>/logs/system/log_OWBDeployment_YYYYMMDD_####.txt 

• Custom Mapviewer deploy Logs

<INSTALL_DIR>/logs/system/mapviewerdeploy.sh.log

• WriteBack Logs

<INSTALL_DIR>/logs/system/Writeback.log

• FileProcessorDaemon Logs

<INSTALL_DIR>/bin/FileProcessorDaemon.log

Log into OBIEE analytics link that is pointing to demo database. Dashboard should display the 
data with no errors.
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Chapter 7 
Demo Installation Procedure 

This chapter provides instructions for installing the demo database. 

Note: Demo installation does not support ETL functionality. ETL Job control 
dashboard accesses the OWB tables and demo dump does not have OWB 
objects; hence, ETL dashboard is not supported in demo installation. 

The chapter includes the following topics: 

• Before You Install

• OUASA Database Component Installation

• OUASA Dashboard Component Installation

• After the Installation
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Before You Install
Refer to article 1391459.1 on My Oracle Support for up-to-date additional information on Oracle 
Utilities Advanced Spatial and Operational Analytics installation.

OUASA Database Component Installation
This section describes how to install demo component of Oracle Utilities Advanced Spatial and 
Operational Analytics. The section includes the following:

• Copying and Decompressing Install Media

• Database Creation and Dump File Import

• Security Configuration

• Spatial Configuration

Copying and Decompressing Install Media
To copy and decompress the install media, follow these steps:

1. Download the Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Oracle 
Database part from Oracle Software Delivery Cloud.

2. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp. (Referred to 
below as <TEMPDIR>) This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation.

3. Copy the file OUASA-V2.4.0-Database-Multiplatform.zip from the delivered package to the 
<TEMPDIR>.

4. Unzip the zip file using any zip utility.

Database Creation and Dump File Import
Ensure that Oracle Database Server Enterprise Edition 11.2.0.2 is already installed on machine in 
order to create database.

The database creation tool (cdxdba.plx for UNIX or CDXDBA.exe for Windows) can be used for 
creating the demo database with AL32UTF8 character set.

Note: The UNIX and Windows database creation utilities will create an empty 
database with AL32UTF8 character set and at least one tablespace for storing 
the application objects before running the installation. The default name of the 
application tablespace is CISTS_01. 

UNIX Database Creation Utility
The files are located in BI240/DatabaseCreation/Unix to create the database.

1. FTP the contents of the Database Creation folder to a temporary directory on the UNIX 
server.

2. To create the database, set the ORACLE_HOME and the ORACLE_BASE variables.

3. Execute the utility cdxdba.plx by executing the following command:

perl cdxdba.plx

4. Provide the following parameter values when the script prompts:

Instance name (DEMO): DEMO
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ORACLE_BASE: the directory where the setup files for the database will be created (/
orasw/app/oracle):

ORACLE_HOME: the folder where the current version of Oracle software is installed 
(/orasw/app/oracle/product/):

ORACLE_DATA: the directory where the data files for the database will be created (/
db05/oradata):

Character set for the database (AL32UTF8):

5. Enter the values based on the settings of your database server. You can also accept the default 
values displayed if they match your database server settings. You will be prompted to confirm 
the settings and select Y or N to create the database.

ORACLE_SID: DEMO

ORACLE_HOME: /orasw/app/oracle/product/

ORACLE_BASE: /orasw/app/oracle

ORACLE_DATA: /db05/oradata

Character Set: AL32UTF8

Do you want to continue (Y/N)?

6. When the database has been created, you will be prompted with the following questions:

Do you want to import a demo database dump into this database (Y/N)?

Select Y to import the Demo Install data.

For the demo installation use the dump file exp_demo.dmp.

Do you want to import a demo database dump into this database (Y/N)? Y

Enter the name of the dump file (exp_demo.dmp):

Enter the name of the dump file directory (data_pump_dir):

Enter the name of the log file (exp_demo.log):

Note: The data_pump_dir must exist in the database created above before 
continuing with the import. You should also copy the exp_demo.dmp file to 
the data_pump_dir. Uncompress the exp_demo.dmp.gz file first to extract the 
exp_demo.dmp file. This file is in ..\BI240\Demo directory.

Set the query_rewrite_enabled parameter to FORCE and the 
query_rewrite_integrity parameter to TRUSTED in the database.

Connect to sys user and execute the following commands:

alter system set query_rewrite_enabled=force;

alter system set query_rewrite_integrity=trusted;

Update the oratab  file for the new database and then check the connectivity to 
this database from another server and from your desktop after updating local 
tnsnames.ora file.

Demo data can also be imported by using below command after successful 
database creation.

Set the correct ORACLE_SID and ORACLE_HOME first and then run 
below command to import demo dump.

impdp directory= data_pump_dir dumpfile= exp_demo.dmp logfile= 
exp_demo.log  schemas=DWADM.
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Windows Database Creation Utility
The files are located in ..\BI240\DatabaseCreation\Windows. You should be logged in as a user 
who is a member of local ORA_DBA group on that server. The ORA_DBA group should have 
"administrator" privileges assigned to it.

1. To create a database, run the utility CDXDBA.exe located in the Windows folder from 
command prompt. The utility displays the following options:

E - Export a schema from the database

R - Refresh a schema with a database dump

C - Create/Recreate a local database

H - See help for the command line options

Q - Quit

2. Select option C to create an empty database on your machine and provide below inputs.

• Provide the instance name (DEMO) : <DB Name> e.g BIDEMO

• Enter the character set of the database (AL32UTF8) : AL32UTF8

• Enter ORACLE_BASE: the directory where the setup files for the database will be 
created (c:\oracle) :    <Oracle_Base>  e.g. C:\app\oracle

• Enter ORACLE_HOME: the folder where the current version of Oracle software is 
installed (c:\oracle\product\11.1.0.6\Db_1) :<Oracle_Home> e.g  
c:\app\oracle\db_home

• Enter ORACLE_DATA: the directory where the data files for the database will be 
created (C:\app\oracle\oradata) :<Directory where data files will be created>

3. Once the database has been created, select the R - Refresh a schema option with a database 
dump file to load the Demo Install data.

• Select an option : R

• Enter the instance name (DEMO) : <DB name>

• Is it a LOCAL database (exists on the same machine) (Y/N) : <Please provide Y or N>

• Enter the name of the Oracle account that owns that application schema (spladm) : 
DWADM

• Enter password for DWADM (spladm) : DWADM

• Enter the character set of the database (AL32UTF8) : AL32UTF8

• Enter the name of data pump directory (DATA_PUMP_DIR) : DATA_PUMP_DIR

• Enter the name of the dump file (expDWADM.dmp) :exp_demo.dmp

• Enter the name of the log file (impDWADM.log) :exp_demo.log

The DBA user is the system, password is manager. Option R causes the utility to drop all the 
objects from the schema and import the schema from a database dump file.

For the Demo Installation, use the dump file exp_demo.dmp.

Note: The data_pump_dir must exist in the database created above before 
continuing with the import. You should also copy the exp_demo.dmp file to 
the data_pump_dir. Uncompress the exp_demo.dmp.gz file to extract the 
exp_demo.dmp file. This file is in the ..\BI240\Demo directory.

Set the query_rewrite_enabled parameter to FORCE and the 
query_rewrite_integrity parameter to TRUSTED in database.

Connect to sys user and execute the following commands:
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alter system set query_rewrite_enabled=force;

alter system set query_rewrite_integrity=trusted;

Check the connectivity to this database from another server and from your 
desktop after updating local tnsnames.ora file

Security Configuration
For Security Configuration, perform the following steps: 

1. Navigate to the ..\BI240\DWADM\Security folder.

2. Edit the file OraGenSec.bat, which is in the same location, and replace the parameter 
database-name with the name of your database. This file is provided for your convenience 
and executes the Oragensec.exe utility based on the parameters passed into it.

Note: Ensure to run OraGenSec.bat from a Window 32-bit desktop that has 
the Oracle 11.2.0.2 client installed Your database should already be listed in the 
local file tnsnames.ora.

The script will execute as the following:

oragensec -d DWADM,DWADM,database_name -r DW_READ,DW_USER -
a A -u

DWUSER,DWREAD

3. Execute the edited OraGenSec.bat file from command prompt.

Spatial Configuration
This section describes how to load spatial metadata in USER_SDO* tables for Oracle Utilities 
Advanced Spatial and Operational Analytics. 

Use the following procedure to load spatial metadata in the target database.

1. Create the dump_dir directory in database and copy user_sdo.dmp file from ../B1240/
Spatial-Metadata folder to that location.

2. Import released spatial tables to the target database using following command:

impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=

imp_user_sdo.log schemas=DWADM

Note: Run this command from database server.

3. Review the imp_user_sdo.log file to ensure the tables were imported successfully.

4. After importing the tables, run following SQL scripts from the ../B1240/Spatial-Metadata 
folder:

- sqlplus dwadm/dwadm@database-name @copy_spatial_metadata.sql

- sqlplus dwadm/dwadm@database-name @clean_sdo_release_tbls.sql

5. Review the log files.
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OUASA Dashboard Component Installation
This section describes how to install the dashboard component of Oracle Utilities Advanced 
Spatial and Operational Analytics. The section includes the following:

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• OUASA Dashboard Package Installation Steps

• Post-installation Tasks

Copying and Decompressing Install Media
The Oracle Utilities Advanced Spatial and Operational Analytics application server installation file 
is delivered in jar format for both UNIX and Windows platforms. If you plan to install multiple 
Oracle Utilities Advanced Spatial and Operational Analytics environments operated by different 
Oracle Utilities Administrator user IDs, you must complete each of the following installation steps 
for each Administrator user ID.

1. Login to the application server host (where OBIEE 11.1.1.5.0 software is installed) as the 
Oracle Utilities Advanced Spatial and Operational Analytics administrator user ID (default 
ceases).

2. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp. (Referred to 
below as <TEMPDIR>.) This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation.

3. Copy the file OUASA.V2.4.0-MultiPlatform.jar from the delivered package to the 
<TEMPDIR>. If you are using FTP to transfer this file, remember to use the BINARY 
option for the FTP transfer.

4. Decompress the file:

cd <TEMPDIR>

jar -xvf OUASA.V2.4.0-MultiPlatform.jar

Note: You must have Java JDK installed on the machine used to (un)jar the 
application server installation package. Install the JDK that is supported for the 
install on your platform to be able to use the jar command.

The Java packages are located at: http://java.sun.com/products/archive/index.html

A sub-directory named "OUBI.V2.4.0" is created. It contains the installation software for the 
Oracle Utilities Business Intelligence application server.

Setting Permissions for cistab File in UNIX
Every Oracle Utilities Advanced Spatial and Operational Analytics environment installed on a 
server must be registered in the /etc/cistab file located on that server. On UNIX servers, generally 
only the root user ID has write permissions to the /etc directory. Since the installation process is 
run by the Oracle administrator user ID (cissys), this user ID may not be able to write to /etc/
cistab table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/OUBI.V2.4.0 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Advanced Spatial and Operational Analytics application environment on the 
server) and registers a new environment.
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The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Advanced 
Spatial and Operational Analytics administrator user ID, so that the next time a new environment 
is created by the same Oracle Utilities Advanced Spatial and Operational Analytics administrator 
user ID, you do not need to run the generated script with the root user ID. Instead, the install 
utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you plan to upgrade an existing environment it is your responsibility to take a backup prior to 
the installation process. The installation utility does not create a backup of existing environment.

OUASA Dashboard Package Installation Steps
Before you install verify that the steps mentioned in Prerequisite Software for OUASA 
Dashboard Component are followed. 

To install the OUASA dashboard package, perform these steps. 

1. Change to the <TEMPDIR>/OUBI.V2.4.0 directory.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer.

3. Execute the following script:

For UNIX:

export ORACLE_CLIENT_HOME=<oracle_client_home>

export PERL_HOME=$ORACLE_CLIENT_HOME/perl

export PATH=$PATH:$PERL_HOME/bin

ksh ./install_OUBI.sh

For Windows:

set ORACLE_CLIENT_HOME=<oracle_client_home>

set PERL_HOME=%ORACLE_CLIENT_HOME%\perl

set PATH=%PERL_HOME%\bin;%PATH%

Install_OUBI.cmd

Note: On UNIX, ensure that you have the proper execute permission on 
install.sh.

4. The Oracle Utilities Advanced Spatial and Operational Analytics specific menu appears.

5. Under the Installation Options, enter “OBIEE”.

6. Select the Each Menu Item to configure the values. For detailed description of the values 
see Configuration Worksheet for ETL Component Installation.

************************************

* Environment Installation Options *

************************************

1.

       Oracle Client Home Directory:                      

       Installation Options:                              
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2.

       Environment Mount Point:                           

       Log Files Mount Point:                             

       Environment Name:                                  

       Web Java Home Directory:                           

       Database Home Directory:                           

       Database Type:                                     oracle

Each item in the above list should be configured for a successful install.

Choose option (1,2, <P> Process, <X> Exit):

7. In the below Environment Configuration worksheet, only 1 and 2 menu items are required to 
be configured. For detailed description of these values, see Configuration Worksheet for 
ETL Component Installation.

*****************************

* Environment Configuration *

*****************************

1. Environment Description

       Environment Description:

2. OBIEE Environment Configuration

       Oracle BI Instance Home:

       Oracle BI Home:

       Oracle BI Domain Home:

       Weblogic Domain Console User Name:

       Weblogic Domain Console Host:

       Weblogic Domain Console Port Number:

3. Database Configuration

4. DESIGN REPOSITORY CONFIGURATION

5. DATABASE CHARACTER SET CONFIGURATION

6. EDITING PROCESS FLOW CONFIGURATION

7. EMAIL CONFIGURATION

8. CONTROL CENTRE CONFIGURATION

9. EXTERNAL DATA SOURCE CONFIGURATION

       Path of the External Datasource LOG:

Each item in the above list should be configured for a successful install.

Choose option (1,2,3,4,5,6,7,8,9, <P> Process, <X> Exit):
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8. When you are done with the parameter setup, proceed with the option P. Write the Configure 
file.

9. Once the install has finished successfully, you will need to execute post-installation steps as 
described in Post-installation Tasks.

Post-installation Tasks
Following topics are discussed in this section: 

• Deploying Repository (RPD) File

• Configuring and Deploying MapViewer

• Deploying Write Back

• Deploying Analytics

Deploying Repository (RPD) File
The RPD file is located at: <install_dir>/Reports/rpd/UtilitiesBusinessAnalytics240.rpd, where 
<install_dir> is the OUASA dashboard package installation directory.

To deploy the RPD file, perform these steps:

1. OBIEE 11.1.1.5.0 should have been installed on Windows 32-bit machine before proceeding 
with the steps below.

2. Launch the Administration Tool from your Start menu from the Windows machine. This is 
only available in Windows.

Start > Programs > Oracle Business Intelligence > Administration.

3. Open the RPD in offline mode by selecting File > Open > Offline...

4. Provide the RPD password. For example, “oracle123”.
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5. Edit the connection pools shown below by double clicking on them.

6. In the Init Block Connection Pool group, enter the following:

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

7. In the Init Block Pool - MDM group, provide the following, only for MDM:

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

8. In the MDM Database Connection group, provide the following, only for MDM:

Data source name = MDM database name

User name = CISUSER

Password = CISUSER User password

9. In the ODIDEV Connection Pool group, provide the following:

Data source name = BI database name

User name = DWUSER

Password = DWUSER User password

10. In the OUBI Database Connection group, provide the following:

Data source name = BI database name

User name = DWREAD
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Password = DWREAD User password

11. Click Save.

12. Login into OBIEE Enterprise Manager.

13. Navigate to BI Instance >Coreapplication>Deployment.

14. Lock and edit.

The repository text box will be enabled.

15. Browse to the modified rpd file and submit. The file is in the following location, where 
<install_dir> is the OUASA dashboard package installation directory.

<Install_Dir>/Reports/rpd/UtilitiesBusinessAnalytics240.rpd

16. Provide the RPD password “oracle123” click Apply.

17. Activate the changes and then restart the BI Services.

Note: All the above databases set in the connection pool should be updated in 
tnsnames.ora file in <OBIEE_INSTALL_DIR>/Oracle_BI1/network/
admin.

Deploying the Web Catalog
Note: You must delete the old BI v2.3.2.1 catalogs (if present in 11g OBIEE 
instance) before deploying the catalogs.

To delete the old catalogs, follow these steps:

1. Launch the Catalog Manager from your Start menu.

Start > Programs > Oracle Business Intelligence > Catalog Manager

2. From the File menu, select Open Catalog. The Open Catalog window is displayed.
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3. Specify the following values:

1. From the Type drop-down, select Online.

2. Enter the URL to the analytics Web application in the following form:

http://<OBIEE Host>: <OBIEE Port>/analytics/saw.dll

3. Enter Administrator as the User and ASAadm as the Password.

4. Click OK to close the window.

5. In the tree panel, expand the root folder /.

6. Select the Shared folder.

7. Select the catalogs in the shared folder, right click, and select Delete.

It will prompt for Physical Catalog location configured in Enterprise Manager. This is the server 
path where OBIEE is installed.

To deploy the catalogs, follow these steps:

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin
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ksh ./deploycatalog.sh

Enter the physical catalogs location configured in Enterprise Manager. For example:

<OBIEE_INSTALL_DIR>/instances/instance1/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/
SampleAppLite

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd  %SPLEBASE%\bin

deploycatalog.cmd

Enter the Physical Catalogs location configured in EM For example:

<OBIEE_INSTALL_DIR>/instances/instance1/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/
SampleAppLite

Configuring and Deploying MapViewer
To configure and deploy the MapViewer, perform the following steps: 

1. Login to WebLogic console.

2. In the WebLogic console, create the 'MAP_DS' data source.

3. Lock and edit.

4. Navigate to Services < Data Sources.

5. Select New > Generic Data Source and provide the following:

Name = MAP_DS

JNDI Name = MAP_DS

Database Type = oracle

6. Click Next.

7. Enter the following:

Database Driver = XA thin database driver

8. Click Next.

9. Enter the following Connection properties:

Database Name:BI Database Name

Host Name:Database host

Port:Database port

Database User Name:dwadm

Password:dwadm password

10. Click Next and then click Finish.

11. Click Activate Changes.

12. Update the mapViewerConfig file with below mentioned tags:

File location : <OBIEE_INSTALL_DIR>/Oracle_BI1/bifoundation/jee/
mapviewer.ear/web.war/WEB-INF/conf/
Demo Installation Procedure 7-13



OUASA Dashboard Component Installation
File: mapViewerConfig.xml

13. If there is proxy used, insert the list of host names for all the third party service providers in 
the security_config node.

<proxy_enabled_hosts>

elocation.oracle.com,maps.weatherbug.com,direct.weatherbug.com,api.wxbug.net,de.tiles.wea
therbug.com

</proxy_enabled_hosts>

14. Update the following ns_data_provider node:

<ns_data_providerid="obieeNsdp"

class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

15. Update the current map_tile_server with the following map_tile_server node.

<map_tile_server>

<tile_storage default_root_path="/mytilecache/"/>

</map_tile_server>

16. Update the instance config file location, for example:

FileLocation:

For Unix :

<OBIEE_INSTALL_DIR>/instances/instance1/config/
OracleBIPresentationServicesComponent/coreapplication_obips1

For Windows:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesCo
mponent\coreapplication_obips1

Modify instanceconfig.xml - Update the security Node with the following values. If the 
security Node is not present, add following code before </Serverinstance>:

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>

Deploying Custom MapViewer - To deploy the custom MapViewer, follow these steps:

For Unix:

cd $SPLEBASE/bin

ksh ./deploymapviewer.sh

Enter the WebLogic Domain Console Password. For example, weblogic123

For Windows:

cd %SPLEBASE%\bin

deploymapviewer.cmd

Enter WebLogic Domain Console Password. For example, weblogic123
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Perform the following steps after deploying the custom MapViewer:

1. Update the MapViewer configuration by navigating to MapViewer > Administration > 
Configuration.

2. Add the below content in the mapViewerConfig.xml with appropriate values:

<DB_HOST>,<DBNAME>,<DB_PORT>,<USER>,<PASSWORD>

<map_data_source name="MAPCONN"

jdbc_host="<DB_HOST>"

jdbc_sid="<BI Database Name>"

jdbc_port="<DB_PORT>"

jdbc_user="<DWADM>"

jdbc_password="<!DWADM PASSWORD>"

jdbc_mode="thin"

number_of_mappers="32"

allow_jdbc_theme_based_foi="true"

/>

3. Save and then restart.

Note: The above step has to be performed each time after running the 
deploymapviewer command.

Deploying Write Back
Follow these steps to deploy the write back feature.

1. Open the following file:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesCo
mponent\coreapplication_obips\instanceconfig.xml

2. Update the following <ServerInstance> element according to the following code:

<LightWriteback>true</LightWriteback>

3. Deploy write back as follows:

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

ksh ./deploywriteback.sh

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%/bin

deploywriteback.cmd
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Deploying Analytics
To deploy analytics, follow these steps:

1. Edit the Presentation Services configuration file, "instanceconfig.xml", in the following 
directory:

<OBIEE_INSTALL_DIR>/instances/instance1/config/
OracleBIPresentationServicesComponent/coreapplication_obips1

2. Add the following before the end tag </ServerInstance>

<UI>

<DefaultStyle>oubi</DefaultStyle>

<DefaultSkin>oubi</DefaultSkin>

</UI>

Enabling Analytics Help
To enable the analytics' help, follow these steps:

1. Download Oracle Utilities Advanced Spatial and Operational Analytics User Guide from Oracle 
Software Delivery Cloud.

2. After downloading the OUASA User Guide, change the name of the Help file to OUASA 
Help.pdf.  
Now, place the Help file in <install_dir>/Skin/res, where <install_dir> is the OUASA 
dashboard package installation directory.

3. Run the following commands:

For UNIX:

cd $SPLEBASE/bin

ksh ./deployanalyticsear.sh

Enter the WebLogic Domain Console Password. For example, weblogic123

For Windows:

cd %SPLEBASE%/bin

deployanalyticsear.cmd

Enter the WebLogic Domain Console Password. For example, weblogic123

4. Restart the BI Core services.

5. Restart WebLogic and all BI services after the OBIEE deployment is completed.

6. Login to Analytics and navigate to Administration > Manage Privileges > Write Back > 
Write Back to Database.

7. Click Denied:Authenticated User and select the permission Granted.

After the Installation 
After the installation, perform the following: 

1. Verify Install and Deploy Logs.

Custom Mapviewer deploy logs

<INSTALL_DIR>/logs/system/mapviewerdeploy.sh.log
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WriteBack logs

<INSTALL_DIR>/logs/system/Writeback.log

2. Log into OBIEE analytics link that is pointing to demo database. Dashboard should display 
the data with no errors.
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Chapter 8 
Configuring Your Applications

This chapter provides instructions for configuring additional applications for use with Oracle 
Utilities Advanced Spatial and Operational Analytics. It contains the following topics:

• Spatial Configuration

• OBIEE Configuration

Spatial Configuration
This section contains information related to configuring Oracle Utilities Advanced Spatial Outage 
Analytics and how to set up the spatial data and its corresponding metadata. The mapping 
between the spatial columns and the dimensional columns like State from Address dimension 
would be defined in map meta data that is available as a part of the WebCatalog. Using the spatial 
data and the map meta data, users can view the transactional data on the map view.

As an example, steps to setup the data for United States (US) are mentioned below: 

• Installing US State Spatial Data

• Installing US City Spatial Data

• Installing US Zip Code Spatial Data

• Installing US County Spatial Data

• Configuring NMS Device Spatial Data

• Loading Spatial Metadata

• Improving Performance by Prefetching Map Tiles

Installing US State Spatial Data
Spatial data can be loaded from various sources. One of the approaches is to use the world sample 
data given by Navteq. There is a pointer to the data set from the Oracle Spatial OTN page for 
downloading Partner data:

http://www.oracle.com/technology/products/spatial/htdocs/spatial_partners_data.html

There are various versions of the world sample dataset. These instructions assume that you are 
using the version with a world_sample2010.dmp file. If you have a different version, then these 
instructions may not work and you should refer to the README included in the downloaded 
world_sample.zip file.

These instructions also assume that the sample data will be loaded into the DWADM account, 
used for the Data Warehouse. If you want to follow the instructions in the world sample 
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README file instead, then the data will be loaded into a WORLD_SAMPLE account, and steps 
will need to be changed to use that account instead of DWADM.

Use the following procedure to install the world sample data.

1. Create a work directory on your machine for the data, and change directory to the new 
directory. For example: 

mkdir NAVTEQ 
cd NAVTEQ

2. Unzip the world_sample.zip file you downloaded to the new directory. For example: 

unzip world_sample.zip 

3. Connect to SQLPLUS using DWADM, and remove the old tables (if present). For example: 

sqlplus dwadm/dwadm@database @cln_sample_data.sql 

4. Import the world sample dump file into the DWADM account. For example: 

imp dwadm/dwadm@database file=world_sample2010.dmp 
 log=world_sample.log full=y

5. After importing the world sample dump file, create the MapViewer Spatial metadata using the 
following insert statements: 

sqlplus  dwadm/dwadm@database
INSERT INTO user_sdo_maps SELECT * FROM sdo_maps;
INSERT INTO user_sdo_themes SELECT * FROM sdo_themes;
INSERT INTO user_sdo_styles SELECT * FROM sdo_styles;
INSERT INTO user_sdo_cached_maps SELECT * FROM sdo_cached_maps;

6. Create the State spatial table and metadata are used by the default themes present in the 
OUASA metadata. This assumes that the eLocation web site is being used as the base map. If 
some other base map is used, then the transform parameter will need to specify the SRID of 
the base map being used.

sqlplus  dwadm/dwadm@database
create table q1_states54004 (

      feature_id number,
      feature_name varchar2(255),
      area_id number,
      name_langcode varchar2(35),
      feature_type varchar2(30),
      country_code_3 varchar2(5),
      geometry SDO_GEOMETRY,
      carto_id number(10,0));

insert into q1_states54004
select null, name, null, lang_code, feature_type,

       ISO_COUNTRY_CODE, sdo_cs.transform(geometry, 54004), 
       carto_id

FROM wom_area
WHERE feature_type = 909996

  and iso_country_code = 'USA';

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_STATES54004','GEOMETRY',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);
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create index q1_STATES54004_sdx 
    on q1_STATES54004(geometry) 
    indextype is mdsys.spatial_index;

Installing US City Spatial Data
US City shape data is available in the world sample data set, however, only the three hundred 
largest cities are available there. To find additional sample data for each US State from the US 
Census Bureau, visit:

http://www.census.gov/geo/www/cob/pl2000.html

The following steps can be used to load the sample data for the state of Ohio, and similar steps 
can be followed to load city data for other US states.

1. Click the Ohio Zip Code in Shapefile format and download the zt39_d00_shp.zip file to the 
NAVTEQ directory created in the previous procedure. 

2. Unzip or decompress the pl39_d00_shp.zip file to the NAVTEQ directory. 

3. Download standalone MapBuilder from this location:  
http://www.oracle.com/technetwork/middleware/mapviewer/downloads/index-
100641.html 

4. Start MapBuilder. This is installed when MapViewer is installed. On windows it can be started 
by running:  
java -jar mapbuilder.jar 
Refer to the MapViewer documentation for instructions on installing and running 
MapBuilder from this location: 
   http://www.oracle.com/technetwork/middleware/mapviewer/documentation/index.html  

5. If a connection is not created, then select File -> New Connection, and create a connection 
to the DWADM account in the OUBI Data Warehouse Database. 

6. Select Tools -> Import Shapefile, and click Next. 

7. Click Shapefile. 

8. Browse to the C:\NAVTEQ directory, select the pl39_d00_shp.shp file, and click Open. 

9. Click Next. 

Ensure that the name of the geometry table is set to pl39_d00. If this is not the 
desired name for the spatial table, then the select statement below will need to 
be changed to use the entered name. 

10. Ensure the Create Predefined Theme box is unchecked, and click Next. 

11. Review the Summary information and click Finish. 
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12. Create the Q1_CITY54004 table using the following SQL statement. This assumes that the 
eLocation web site is being used as the base map. If some other base map is used, then the 
transform parameter will need to specify the SRID of the base map being used.

sqlplus  dwadm/dwadm@database
create table Q1_CITY54004 as
select upper(name) FEATURE_NAME,

       sdo_cs.transform(geometry, 54004) geometry,
       'OHIO' state

From pl39_d00
Where lsad_trans in ( 'city', 'village' );

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_CITY54004','GEOMETRY',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);

create index Q1_CITY54004_sdx 
    on Q1_CITY54004 (geometry) 
    indextype is mdsys.spatial_index;

UPDATE q1_city54004
  SET geometry = SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);

Installing US Zip Code Spatial Data
Sample shape files for US Zip Code Areas can be found at the following location:

http://www.census.gov/geo/www/cob/z52000.html

The following steps can be used to load the sample data for the state of Ohio, and similar steps 
can be followed to load zip code data for other US states.

1. Click on the Ohio Zip Code in Shapefile format and download the zt39_d00_shp.zip file to 
the NAVTEQ directory created in the previous procedure. 

2. Unzip the zt39_d00_shp.zip file to the NAVTEQ directory. 

3. Start MapBuilder. This is installed when MapViewer is installed. Refer to the MapViewer 
documentation for instructions on installing and running MapBuilder.
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4. If a connection is not created, then select File > New Connection, and create a connection 
to the DWADM account in the OUBI Data Warehouse Database. 

5. Select Tools > Import Shapefile and click Next. 

6. Click Shapefile. 

7. Navigate to the C:\NAVTEQ directory, select the zt39_d00.shp file, and click Open. 

8. Click Next. 

Note: Ensure the name of the geometry table is set to ZT39_D00. If this is not 
the desired name for the spatial table, then the select statement below will need 
to be changed to use the entered name.  

9. Ensure the Create Predefined Theme box is unchecked, and click Next. 

10. Review the Summary information and click Finish. 

11. Create the Q1_USZIP54004 table using the following SQL statement. This assumes that the 
eLocation web site is being used as the base map.  If some other base map is used, then the 
transform parameter will need to specify the SRID of the base map being used.

sqlplus  dwadm/dwadm@database

create table q1_USZIP54004 as

select zcta ZCTA5CE,
       sdo_cs.transform(geometry, 54004) geom

From ZT39_D00;

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_USZIP54004','GEOM',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);

create index q1_USZIP54004_sdx 
    on q1_USZIP54004 (geom) 
    indextype is mdsys.spatial_index;

UPDATE q1_uszip54004
  SET geom = SDO_UTIL.RECTIFY_GEOMETRY(geom, .05);
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Installing US County Spatial Data
Sample shape files for US Counties can be found at the following location:

 http://www.census.gov/geo/www/cob/co2000.html

The following steps can be used to load the sample data for the state of Ohio, and similar steps 
can be followed to load county data for other US states.

1. Click on the Ohio County in Shapefile format and download the co39_d00_shp.zip file to the 
NAVTEQ directory created in the previous procedure. 

2. Unzip the co39_d00_shp.zip file to the NAVTEQ directory. 

3. Start MapBuilder. This is installed when MapViewer is installed. Refer to MapViewer 
documentation for instructions on installing and running MapBuilder.

4. If a connection is not created, then select File > New Connection, and create a connection 
to the DWADM account in the OUBI Data Warehouse Database. 

5. Select Tools > Import Shapefile, and click Next. 

6. Click Shapefile. 

7. Browse to the C:\NAVTEQ directory, select the co39_d00_shp.shp file, and click Open. 

8. Click Next. 

Note: Ensure the name of the geometry table is set to CO39_D00. If this is 
not the desired name for the spatial table, then the select statement below will 
need to be changed to use the entered name.

9. Ensure the Create Predefined Theme box is unchecked, and click Next. 

10. Review the Summary information and click Finish. 

11. Create the Q1_COUNTY54004 table using the following SQL statement. This assumes that 
the eLocation web site is being used as the base map. If some other base map is used, then the 
transform parameter will need to specify the SRID of the base map being used.

sqlplus  dwadm/dwadm@database

create table q1_COUNTY54004 as
select name FEATURE_NAME,

       sdo_cs.transform(geometry, 54004) geometry,
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       'OHIO' state
From CO39_D00;

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_COUNTY54004','GEOMETRY',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);

create index q1_COUNTY54004_sdx 
    on q1_county54004 (geometry) 
    indextype is mdsys.spatial_index;

UPDATE q1_county54004
  SET geometry = SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);

Note: No predefined reports make use of the County data, so if county spatial 
reports are desired, the Q1_COUNTY_54004 theme will need to be used in 
new requests and maps.

Configuring NMS Device Spatial Data
To implement the NMS Network Model on the spatial analytics, OUASA reports need NMS 
geometry data. The steps from this section are required to view data in spatial reports of Outage 
Analytics. There are several ways that the geometry data in the DIAGRAM_OBJECTS NMS 
device table can be accessed by the OUASA Mapping reports. 

This section describes the following methods:

• Replicating the DIAGRAM_OBJECTS Table

• Accessing the NMS Spatial Data Using a Database Link

Replicating the DIAGRAM_OBJECTS Table
The easiest option is to replicate the DIAGRAM_OBJECTS table into the OUASA database. If 
this is done, then after replicating the DIAGRAM_OBJECTS table, the following steps will setup 
the OUASA dashboards to use the data in this replicated table.

1. Create the required Spatial Metadata:

INSERT INTO user_sdo_geom_metadata 
VALUES ( 'DIAGRAM_OBJECTS','LL_GEOMETRY',

MDSYS.SDO_DIM_ARRAY(
        SDO_DIM_ELEMENT('X', -20037508, 20037508, .05),
        SDO_DIM_ELEMENT('Y', -45884542, 45884542, .05)
), 54004);

2. Ensure that the spatial index is created on the LL_GEOMETRY column. The 
LL_GEOMETRY column by default stores spatial data using SRID 54004, so this will work 
without changes with the eLocation base map:

create index q1_DIAGRAM_OBJECTS_sdx 
    on diagram_objects (ll_geometry) 
    indextype is mdsys.spatial_index;

3. In MapBuilder, use duplicate to create a copy of the B1_THEME_DIAGRAMOBJ_54004 
Geometry Theme, with the following settings:

• New Name: Q1_THEME_DIAGRAMOBJ_54004

• Target Database: OUASA Database
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• Base Table: DIAGRAM_OBJECTS

• Spatial Column: LL_GEOMETRY

Once DIAGRAM_OBJECTS table is replicated to the OUASA database, follow the below steps 
to create Q1_DIAGRAM_OBJECTS_54004 table:

1. Connect to DWADM schema of OUASA database and execute "create table 
Q1_DIAGRAM_OBJECTS_54004 as select * from DIAGRAM_OBJECTS;"

2. INSERT INTO user_sdo_geom_metadata 
VALUES ( 'Q1_DIAGRAM_OBJECTS_54004','LL_GEOMETRY', 
MDSYS.SDO_DIM_ARRAY(SDO_DIM_ELEMENT('X', -20037508, 20037508, 
.05),SDO_DIM_ELEMENT('Y', -45884542, 45884542, .05)), 54004);

3. Create index q1_DIAGRAM_OBJECTS_sdx_54004 on Q1_DIAGRAM_OBJECTS_54004 
(ll_geometry) indextype is mdsys.spatial_index;

Accessing the NMS Spatial Data Using a Database Link
If it is not possible to replicate the DIAGRAM_OBJECTS table, and no existing NMS Geometry 
theme can be used, then it is possible to access the DIAGRAM_OBJECTS table in the OUASA 
database using a database link. 

To access the DIAGRAM_OBJECTS table in the OUASA database using a database link:

1. Create a database link in the OUASA database pointing to the NMS database.

2. Create a synonym DIAGRAM_OBJECTS for the DIAGRAM_OBJECTS table in the NMS 
database.

3. Update the mapViewerConfig.xml to add another datasource, pointing to the NMS database, 
just like the OUASA datasource was added earlier in the install documentation

4. Restart WebLogic to make the NMS database available.

5. Create the required Spatial Metadata in the OUASA database:

INSERT INTO user_sdo_geom_metadata 
VALUES ( 'DIAGRAM_OBJECTS','LL_GEOMETRY',

MDSYS.SDO_DIM_ARRAY(
   MDSYS.SDO_DIM_ELEMENT('LONGITUDE',-180,180,0.05),
   MDSYS.SDO_DIM_ELEMENT('LATITUDE',-90,90,0.05)
), 54004);

6. In MapBuilder, use duplicate to create a copy of the B1_THEME_DIAGRAMOBJ_54004 
Geometry Theme, with the following settings:

• New Name: Q1_THEME_DIAGRAMOBJ_54004

• Target Database: OUASA Database

• Base Table: DIAGRAM_OBJECTS

• Spatial Column: LL_GEOMETRY

Loading Spatial Metadata
This section describes how to load spatial metadata in USER_SDO* tables for Oracle Utilities 
Oracle Utilities Advanced Spatial Operational Analytics. 

Use the following procedure to load spatial metadata in the target database.

1. Create the dump_dir directory in database and copy user_sdo.dmp file from ../B1240/
Spatial-Metadata folder to that location. 

2. Import released spatial tables to the target database using following command:

impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=  
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    imp_user_sdo.log  schemas=DWADM

Note: Run this command from database server.

3. Review the imp_user_sdo.log file to ensure the tables were imported successfully.

4. After importing the tables, run following SQL scripts from the ../B1240/Spatial-Metadata 
folder:

- sqlplus dwadm/dwadm@database-name @copy_spatial_metadata.sql

- sqlplus dwadm/dwadm@database-name @clean_sdo_release_tbls.sql

5. Review the log files.

Flushing Map Cache
Before you can begin using the modified base map, you must flush the map cache as follows:

1. In the MapViewer Console, click Admin in the top-right corner of the page and log in to the 
Admin Console page.

2. Click Management, select Manage MapViewer, and then select Datasources.

3. Click Purge cached metadata.

4. To verify the map changes, go to the Map zone that references the modified base map.

5.  Delete the 'cacheduserinfo' files in the following path to remove any cache:

<OBIEE_INSTALL_DIR>\instances\instance2\bifoundation\OracleBIPresentationServi
cesComponent\coreapplication_obips1\catalog\SampleAppLite\root\users\weblogic2
\_prefs

Improving Performance by Prefetching Map Tiles 
Rendering map tiles dynamically can affect system performance. To avoid this you should 
consider prefetching tiles by issuing an admin request to MapViewer on a non-production 
server or when the server is not under load. When MapViewer receives a prefetching request, 
it issues many concurrent map tile requests to itself, which are basically XML map requests, 
and stores them in the cache. This improves the system’s performance as the images are 
readily available.

Follow the following procedure to prefetch map tiles.

1. In the MapViewer Console, click Admin in the top-right corner of the page and log in to the 
Admin Console page.

2. In the Admin Console page, click Manage Map Tile Layers.

3. Click Manage to display the list of existing map tiles.

4. Select the required map tile and click View map/Manage Tiles.
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The Prefetching wizard opens:

5. Enter the X, Y coordinates of the center of the map, and the SRID and Zoom Level, and 
click Show Map. 

To prefetch map images, you need to enter the latitude and longitude values. A client needs to 
know the latitude and longitude values of the center of the location in interest. SRID is a 
unique value used to identify the coordinate system used in a GIS application. The SRID used 
is 8307. 

The X and Y axis used in the following example is for Canton, Ohio:

6. When you see the map, turn on the Area Selection Tool and select the area on the map for 
which you want to prefetch the tiles.

7. Select one or more zoom-levels for which you want to prefetch the tiles.

8. Under Tile Operations, click on Prefetch Tiles.

This process will take some time, depending upon the hardware configuration of the system and 
the amount of data to be prefetched. To check the current status of the operation, click Refresh 
under Operation Status. The status will change to “Finished” when the operation is done.

OBIEE Configuration
This section contains information about configuring Oracle Business Intelligence Enterprise 
Edition (OBIEE) for use with Oracle Utilities Advance Spatial and Operational Analytics. 
Following topics are discussed: 

• Setting Up and Configuring User Security

• Managing Content in the Presentation Catalog

Setting Up and Configuring User Security
Refer to the Configuring User Security section in the Oracle Utilities Advanced Spatial and Operational 
Analytics Administrator's Guide for details on configuring user security.
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Managing Content in the Presentation Catalog
Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Presentation Catalog has a 
different folder for each of the analytics.

The following folders are available on the Shared Folders:

• About

• Administration

• Common

• Credit & Collections Analytics

• Customer analytics

• Distribution Analytics

• Meter Data Analytics

• Mobile Workforce Analytics

• Outage Analytics

• Revenue Analytics

• Shared Objects

• Work & Asset Analytics

For more information on User Security and Managing Catalog objects, refer to the Oracle Business 
Intelligence Presentation Services Administration Guide.

Managing Folders and Content 
New folders can be created by the customer if new Answers or modifications to existing ones are 
needed.

To create new folders (or Development Folders), log on to the Presentation Services as an 
Administrator and access:

Catalog -> New Folder

Once a new folder is created, the following values can be set:

• Properties

• Name 

• Delete

• Permissions

• Copy/Move

The customer can save new Answers onto the development folders, thereby leaving the out-ofbox 
folders as is. Once the Answer is created, the report is written and unit testing is complete, the 
request can be moved to the common folder.

Default folders are loaded during the install of OBIEE. These folder, such as 00 Overview, 01 
Ranks & Toppers, or 02 History & Benching, can be removed from view by navigating to Catalog, 
and then deleting the dashboards that you do not want displayed from the list.

Editing Names and Descriptions of Objects 
To edit names and descriptions of objects, log on to the Presentation Services as an Administrator 
and access:

Catalog > Shared Folders
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Chapter 9 
Installing Optional Software

This chapter describes the optional software that can be installed with Oracle Utilities Advanced 
Spatial and Operational Analytics. Following is discussed here: 

• Oracle Utilities Business Intelligence

Oracle Utilities Business Intelligence
For information on installing Oracle Utilities Business Intelligence v2.4.0, see the Oracle Utilities 
Business Intelligence Installation Guide and Oracle Utilities Business Intelligence DBA Guide that are 
included in the Oracle Utilities Advanced Spatial and Operational Analytics Media Pack.
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Chapter 10 
Additional Information for Installing Other 

Oracle Software

This chapter provides information about indtalling other Oracle software while installing Oracle 
Utilities Advanced Spatial and Operational Analytics.

The chapter includes:

• Oracle Warehouse Builder 11.2.0.2

• Oracle Business Intelligence Enterprise Edition 11.1.1.5.0

Oracle Warehouse Builder 11.2.0.2
Oracle Warehouse Builder 11.2.0.2 is pre-installed with Oracle Database 11.2.0.2 and hence is not 
required to be installed separately.

Oracle Business Intelligence Enterprise Edition 11.1.1.5.0
Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 is supported with Oracle 
Business Intelligence Suite Enterprise Edition Version 11.1.1.5.0.

Refer the Oracle Business Intelligence Suite Enterprise Edition Documentation Library for 
installation instructions.
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Appendix A
Data Warehouse Implementation Guidelines

This chapter provides guidelines for implementing the data warehouse setup for Oracle Utilities 
Advanced Spatial and Operational Analytics. 

The following sections are discussed in detail:

• Init.ora Settings

• Oracle Partitioning

Init.ora Settings
Internal performance testing for a large Business Intelligence (BI) database installation has 
identified the following parameter settings that resulted in a fast load and materialized view refresh 
for a fact table with over 100,000,000 records.

Note that the settings mentioned in the below table were noticed for an Oracle 10.2 database 
running on an IBM AIX 5.2 machine with 8 CPUs and 15 GB of memory; hence, some of these 
values may not apply for different hardware or software settings.

Parameter Value

db_file_multiblock_read_count 32

db_cache_size 0M

shared_pool_size 0M

large_pool_size 0M

Java_pool_size 0M

parallel_max_servers 8

parallel_execution_message_size 65535

log_buffer 64554432

Pga_aggregate_target 2000M

query_rewrite_enabled FORCE

query_rewrite_integrity TRUSTED

session_cached_cursors 60

optimizer_index_caching 80

optimizer_index_cost_adj 30

Sga_max_size 4000M

Sga_target 2000M

shared_pool_reserved_size 64M
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Oracle Partitioning
As the primary keys for all tables are sequential, it is possible to partition any table based on the 
primary key field. However, the Fact tables should be partitioned based on one of the Date Keys 
present in the table. Some of the date keys are optional; hence, it is important to pick a date key 
field that will always have a non-zero value.

Note that as the RECENT fact table needs to be purged daily, it does not require to be 
partitioned. Also, partitioning should be done only when materialized views do not prove 
sufficient enough to achieve the desired performance. 

For details on partitioning, refer to the Oracle Utilities Advanced Spatial and Operational Analytics 
Admininstrator’s Guide. 

workarea_size_policy AUTO

db_writer_processes 8

timed_statistics False

cursor_space_for_time True

Disk_asynch_io True

Parameter Value
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Appendix B
Installation Menu Functionality

This chapter provides functionality details regarding installation menu for installing the Oracle 
Utilities Advanced Spatial and Operational Analytics application. 

The following sections are discussed here:

• Installation Menu Functionality Overview

• Installation Menu Functionality Details
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Installation Menu Functionality Overview
Installation Menu Functionality Overview
The main configuration menu is structured so that related variables and/or options are grouped 
together and are associated by a menu item number. To access a particular group of variables and 
options, enter the menu item number associated with that group. Each option within a group is 
displayed in turn on the screen along with a prompt so that you can type the desired value for the 
option, if it is not the same as the default or current value.

When performing the initial installation, you need to go through all menu options. The menu 
options may have a default value, a list of valid values, and a validation check.

On each option prompt, you can keep the current value by simply leaving the input line empty. In 
order to erase a variable value, you need to enter a single dot ("."). The leading spaces are trimmed 
out on each values that are entered.

Note: While working with the menu, you will notice the following:

• Valid Values: [ALFANUM]. This indicates you will need to enter an alphanumeric value 
in the prompt.

• Valid Values: [NUM]. This indicates you will need to enter an numeric value in the 
prompt.

When all the menu options are set, type <P> at the main menu prompt option. The option values 
selected throughout the configuration are saved. 

During this processing, the global variables are validated and the configuration file 
<SPLEBASE>/etc/ENVIRON.INI is created or updated. This file contains all the variables 
inputted and calculated. These are required by the next part of the installation process.

To exit the configuration utility without saving any of the values entered, type <X> and click 
Enter. 

Installation Menu Functionality Details
The Environment Installation Utility requires that Oracle Client Home is set in the path for the 
user performing the installation. Prior to running the installation utility, you must review the 
supported platforms document to ensure that you have all  the required Third-Party software 
installed at your end. In the Installation menu if the variables are set prior to execution, then these 
variable values will be defaulted by the installation utility during installation.

When installation completes successfully, the values will be written to an ENVIRON.INI file. 
When splenviron.sh / cmd is executed, it reads from the ENVIRON.INI file to set the 
environment variables.

In the worksheets, there are three different types of values given:

• Default Values are the values that will be defaulted when running the installation utility.

• Security Values denote values that should be changed when in production.

• Example Values are values that can be used for a default installation.

Note: The production environment should not be run with default values.

Refer to the Server Administration Guide for additional information about configuring these values.

When you enter passwords, you do not see the password characters on the screen as they are 
entered in silent mode. Passwords are encrypted when the values are entered by a user.

Install the Oracle Client software specified in the section Supported Platforms prior to running 
any of the installation utilities. 

The following prompt appears when executing the installation utility:

Enter Oracle Client Home Directory (<ENTER> quit):
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Installation Menu Functionality Overview
Note: If the environmental variable ORACLE_CLIENT_HOME is set, then 
the install script validates the variable. If it passes the validation, you will not be 
prompted for it. This is needed in order to run Perl installation utilities.
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Appendix C
Installation and Configuration Worksheets

This chapter provides the installation and configuration worksheets for Oracle Utilities Advanced 
Spatial and Operational Analytics. 

Following topics are discussed: 

• Configuration Worksheet for ETL Component Installation

• Configuration Worksheet for Dashboard Component Installation
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Configuration Worksheet for ETL Component Installation
Configuration Worksheet for ETL Component Installation
Environment installation options are as shown in the section  below:

Environment Installation Options

Environment Configuration Options

Environment Installation Options

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Oracle Client Home 
Directory

ORACLE_CLIENT_H 
OME

The home directory of 
the Oracle Client. The 
application will use the 
Perl included under this 
Oracle Client.

Example Location:
/oracle/client/product/
11.2.0.2

Installation Options OWB (OWB 
components)

OBIEE (OBIEE 
Components)

ALL (OWB and OBIEE 
Components)

Installation type to be 
selected. 

The following are the 
meaning of each 
installation type: 

OWB: This will install 
only the OWB 
components. 

OBIEE: This will install 
only the OBIEE 
components.  

ALL: This will install 
both OWB and OBIEE 
components. Select this 
option if both OWB and 
OBIEE will be deployed 
on the same server.  

Select the OWB Option
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Configuration Worksheet for ETL Component Installation
Environment Mount 
Point

<SPLDIR> The mount point into 
which the application is 
installed. 
Local directory Where 
components to be 
installed.

For example:
/OUASA for UNIX and 
C:\OUASA for 
Windows

This mount point 
MUST exist and the 
administrator user ID 
MUST be able to write 
to this directory. (This is 
the user ID that is 
created specifically to 
administer the  
environments; the 
installation sets 
permissions on all 
subdirectories installed 
under this directory.

See <SPLENVIRON> 
below for more 
information on how this 
mount point is used.

Log File Mount Point <SPLDIROUT> A mount point that will 
contain any application 
output or application 
logs. 
Example value is /
OUASA/sploutput for 
UNIX installation or 
C:\OUASA\sploutput 
for Windows

Note: This value is 
currently not used and 
can be skipped.

Menu Option Name Used In 
Documentation Usage Customer Install 

Value
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Configuration Worksheet for ETL Component Installation
Environment Configuration Options
Following topics are discussed in this section: 

• Environment Description

• Database Configuration

• Design Repository Configuration

•  EMAIL Configuration

• Control Center Configuration

• External Data Source Configuration

Environment Description
Environment description details are as shown in the table below: 

Environment Name <SPLENVIRON> A descriptive name to be 
used as both a directory 
name under the mount 
point
<SPLDIR> and an 
environment descriptor. 
This value typically 
identifies the purpose of 
the environment. For 
example, DEV01 or 
CONV

Web Java Home 
Directory

JAVA_HOME The location on the disk 
where Java 1.6 is 
installed. 

For example:
$ORACLE_BI_HOME
/jdk

Database Home 
Directory

DATABASE_HOME Location on the disk 
where database client is 
installed for your 
particular installation.

Example location for 
Oracle Database:
/oracle/client/product/
11.2.0.2

Database Type The type of the database 
e.g. oracle, mssql or db2
Currently only "oracle" 
is supported.

oracle

Menu Option Name Used In 
Documentation Usage Customer Install 

Value
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Configuration Worksheet for ETL Component Installation
Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Environment 
Description

DESC This is a free form text 
field to describe the 
purpose of the 
environment.

Database Configuration

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

OWB WorkSpace 
Owner

OWB_WS_OWNER OWB workspace Owner 
that is created in 
Creating and 
Configuring 
Workspace for an 
Initial Installation.

BIREPOWN

OWB WorkSpace 
Owner Password

OWB_WS_OWNER_P
ASS

OWB workspace Owner 
Password that is created 
in Creating and 
Configuring 
Workspace for an 
Initial Installation.

The password to login 
to Oracle warehouse 
Builder design center.

This is a Security Value.

BIREPOWN

Database Name OBIEE_DBNAME The name of the 
database instance that 
the application will be 
connecting to.

BI Database Name

Database Server OBIEE_DBSERVER Host name of the server 
where database resides.

BI Database Server

Database Port OBIEE_DBPORT Database port number 
on the database server 
used for connecting to 
the database

BI Database PORT
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Configuration Worksheet for ETL Component Installation
Menu Option Name Used In 
Documentation Usage Customer Install 

Value

OWB WorkSpace User OWB_WS_USER OWB workspace User 
that is created in 
Creating and 
Configuring 
Workspace for an 
Initial Installation.

The User to login to 
Oracle warehouse 
Builder design Control 
center.

BIREPO

OWB Workspace user 
Password

OWB_WS_PASS OWB workspace User 
Password that is created 
in Creating and 
Configuring 
Workspace for an 
Initial Installation.

The password to login 
to Oracle warehouse 
Builder design Control 
center.

This is a Security Value.

BIREPO

OWB WorkSpace Name OWB_WS_NAME The name of the 
Workspace created using 
Repository Assistant

SPLBIREP

DWADM SCHEMA 
NAME

DWADM_SCHEMA The user ID to Register 
OWB locations

DWADM

DWADM SCHEMA 
Password

DWADM_PASS The password to 
Register OWB locations

DWADM

WORKFLOW 
MANAGER SCHEMA 
NAME

OWFMGR_SCHEMA The user ID to Register 
OWB locations

OWFMGR

DWADM SCHEMA 
Password

OWFMGR_PASS The password to 
Register OWB locations

OWFMGR

Design Repository Configuration

Database Character Set Configuration

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Database Character set DBCS Database character Set 
to used to create the 
database

AL32UTF8
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Configuration Worksheet for ETL Component Installation
Editing Process Flow Configuration

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Repository Operating 
System

REPOPSYS Database operating 
system, for example, 
Win or Linux (any other 
platform)

Valid Values:
Win: windows
Linux: for any non 
windows platforms

Perl Compiler location PERLCMD Perl compiler set in 
database. For example:
/usr/bin/perl

<ORACLE_CLIENT>
/perl/bin/perl

Data and control files 
location

CTLFOLDER Data and control file 
extracts location, where 
flat files placed to 
pickup by the file 
processor.

For example: user 
location

Separator to be used FILESEP Separator to be used for 
OWB deployment, 
where database resides.

For example: Win '\\' 
and for Linux '/

For Unix      /
For Windows   \\

File Manager location FILEMGR File Manager location on 
the database server. 
Copy the 
splfilemanager.plx file 
from BI240/Scripts 
directory to this 
location.

EMAIL Configuration

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Email ID of Sender EMAILIDSEN Email ID of sender to 
be configured in OWB 
while in deployment

For example: 
OWB@oracle.com
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Configuration Worksheet for ETL Component Installation
Control Center Configuration

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Repository Control 
Center Name

CCNAME OWB Repository 
Control center to 
created or used to 
deploy the OWB objects

External Data Source Configuration

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Path of the External 
Datasource

EXTERNAMEDS Path of the extracts 
location

Path of the External 
Datasource LOG

EXTERNAMEDS_LO
G

Path of the extracts log 
location

File Processor Daemon 
Execution Switch

FPDEXECUTION_S
WITH

File processor execution 
switch

1

File Processor Extract 
Max Load

FPDEXTRACT_MAX
LOAD

File processor to pick up 
the Extractor to load

5

File Processor Scheduler 
Poll Duration

SCHEDULER_POLL_
DURATION

File Processor Scheduler 
Poll Duration

60

Email ID for Reply-To 
address

EMAILIDRPL Email ID of Reply TO 
to be configured in 
OWB while in 
deployment

Email ID of Receiver EMAILIDREC Email ID of Receiver to 
be configured in OWB 
while in deployment

SMTP server SMTPSRV Host name of the server 
where SMTP Service 
Configured

SMTP server port SMTPPORT Port number on the 
server where SMTP 
Service Configured

Menu Option Name Used In 
Documentation Usage Customer Install 

Value
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Configuration Worksheet for ETL Component Installation
Configuration Worksheet for Dashboard Component Installation
Following topics are included here: 

• Environment Installation Options

• OBIEE Environment Configuration Options

Environment Installation Options

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Oracle Client Home 
Directory

ORACLE_CLIENT_H 
OME

The home directory of 
the Oracle Client. The 
application will use the 
Perl included under this 
Oracle Client.

Example location:
/oracle/client/product/
11.2.0.2

Installation Options OWB (OWB 
components)
OBIEE (OBIEE 
Components)
ALL (OWB and OBIEE 
Components)

Installation type to be 
selected. 

The following are the 
meaning of each 
installation type: 

OWB: This will install 
only the OWB 
components. 

OBIEE: This will install 
only the OBIEE 
components.  

ALL: This will install 
both OWB and OBIEE 
components. Select this 
option if both OWB and 
OBIEE will be deployed 
on the same server.  

Select OBIEE Option
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Configuration Worksheet for ETL Component Installation
Environment Mount 
Point

<SPLDIR> The mount point into 
which the application is 
installed. For example:
/OUASA for UNIX and 
C:\OUASA for 
Windows

This mount point 
MUST exist and the 
administrator user ID 
MUST be able to write 
to this directory. (This is 
the user ID that is 
created specifically to 
administer the  
environments; the 
installation sets 
permissions on all 
subdirectories installed 
under this directory.

See <SPLENVIRON> 
below for more 
information on how this 
mount point is used.

Log File Mount Point <SPLDIROUT> A mount point that will 
contain any application 
output or application 
logs. 

Example value is /
OUASA/sploutput for 
UNIX installation or 
C:\OUASA\sploutput 
for Windows

Note: This value is 
currently not used and 
can be skipped.

Environment Name <SPLENVIRON> A descriptive name to be 
used as both a directory 
name under the mount 
point <SPLDIR> and 
an environment 
descriptor. This value 
typically identifies the 
purpose of the 
environment. For 
example, DEV01 or 
CONV

Menu Option Name Used In 
Documentation Usage Customer Install 

Value
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Configuration Worksheet for ETL Component Installation
OBIEE Environment Configuration Options

Web Java Home 
Directory

JAVA_HOME The location on the disk 
where Java 1.6 is 
installed. 

For example:
$ORACLE_BI_HOME
/jdk

Database Home 
Directory

DATABASE_HOME Location on the disk 
where database client is 
installed for your 
particular installation.

Example location for 
Oracle Database:
/oracle/client/product/
11.2.0.2

Database Type The type of the database 
e.g. oracle, mssql or db2
Currently only "oracle" 
is supported.

oracle

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Oracle BI Instance 
Home

ORACLE_INSTANCE Location on the disk 
where OBIEE software 
is installed instance 
home.

Example location for 
Oracle Database:
/orasw/BLDENGBI/
instances/instance1

Oracle BI Home ORACLE_BI_HOME Location on the disk 
where OBIEE software 
is installed Oracle_BI 
Home.

Example location for 
Oracle Database:
/orasw/BLDENGBI/ 
Oracle_BI1

Menu Option Name Used In 
Documentation Usage Customer Install 

Value
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Configuration Worksheet for ETL Component Installation
Oracle BI Domain 
Home

DOMAIN_HOME Location on the disk 
where OBIEE software 
is installed Oracle_BI 
Home.

Example location for 
Oracle Domain home:
/orasw/BLDENGBI/ 
user_projects/domains/ 
bifoundation_domain

WebLogic Domain 
Console User Name

WLS_EM_USER WebLogic domain login 
user name.

You will be prompted 
for the password after 
installation.

WebLogic Domain 
Console Host

WLS_EM_HOST The host name on which 
the web application 
server resides.

Default value: <current 
server name>

WebLogic Domain 
Console Port

WLS_EM_PORT A unique port number 
within the system that 
will be assigned to the 
HTTP port. This is the 
port number that is used 
as a part of the client 
URL request to connect 
to the host.
This will be OBIEE 
weblogic console admin 
port number.

Example value: 7001

Menu Option Name Used In 
Documentation Usage Customer Install 

Value
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Appendix D
Customizing Oracle Utilities Advanced Spatial 

and Operational Analytics

This chapter provides details about customizing Oracle Utilities Advanced Spatial and Operational 
Analytics. 

Following topics are discussed:

• Customizing Web Catalog

• Customizing Repository (RPD) File

• Customizing Oracle Warehouse Builder (OWB) Mappings

• Customizing the File Processor Mappings

Customizing Web Catalog
It is required that all customizations are done in a separate folder in order for those 
customizations to be preserved during the upgrade.

Note that dashboards would still be overwritten during the upgrade and any mappings between 
dashboards and custom (CM) answers will be lost and would need to be re-mapped manually.

Therefore, we recommend that the customer uses a staging (CM) environment for upgrade and 
manual re-mapping of dashboards before moving the upgraded CM content into the production 
environment.

Customizing Repository (RPD) File
It is required that all customizations are done in a separate repository (RPD) file, separated from 
the product's out-of-the-box RPD file. Any CM changes will be merged into the upgraded RPD 
file through the Merge utility of the OBIEE tool, together with the product's out-of-the-box RPD 
file. We recommend that the customer uses a staging (CM) environment for the RPD upgrade.

Customizing Oracle Warehouse Builder (OWB) Mappings
Oracle Warehouse Builder (OWB) mappings can be modified by updating the OUBI Metadata in 
the Table Mapping screen, and running the OWB Generator for the Fact or Dimension table that 
was modified, to generate TCL scripts that can then be loaded into OWB and deployed to the run-
time database.

After an upgrade, the OWB Generator would need to be rerun for any modified fact and 
dimension tables again, since the OWB Mappings will be overwritten by the default mappings in 
an upgrade. We recommend that the customer user a staging (CM) environment to test the OWB 
upgrade and mapping redeployment prior to loading the OWB mappings in a production 
environment.

For other supported OWB modifications, refer to this support document in Oracle Support:
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• Supported Oracle Warehouse Builder Changes for BI Oracle Utilities Business Intelligence 
[ID 877966.1]
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Customizing the File Processor Mappings
Customizing the File Processor Mappings
For adding new mappings so that they can be processed by the File Processor perform the 
following steps:

1. Create the "cm_schedulerParm.properties.exit_1.include" file under templates folder.

For UNIX:

$SPLEBASE/templates

For Windows:

%SPLEBASE%\templates

2. Add the following entry in "cm_schedulerParm.properties.exit_1.include" in the file:

extract.file.mapping.override.count = <COUNT_NUMBER>

Where COUNT_NUMBER is scheduler parameter mapping count from source 
parameter file (viz. extract.file.mapping.count) + user configurable mappings count.

For example:

extract.file.mapping.override.count = 251

3. Add the new user parameter mappings in "cm_schedulerParm.properties.exit_1.include" file.

Example:

extract.file.mapping250 = <MAPPING1>

extract.file.mapping251 = <MAPPING2>

Note: Refer to Oracle Utilities Advanced Spatial and Operational Analytics Administrator's Guide 
for mapping format.

4. Run the initialSetup command:

For UNIX:

$SPLEBASE/initialSetup.sh

For Windows:

%SPLEBASE%\initialSetup.sh

5. Start the File Processor.

For UNIX:

cd $SPLEBASE/bin

nohup ksh ./startFileprocessordaemon.sh > ../tmp/

consoleFileprocessordaemon.log 2>&1 &

For Windows:

startFileprocessordaemon.cmd
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Customizing the File Processor Mappings
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Appendix E
Additional Resources

Contacting Oracle Support
To contact Oracle support, visit the Oracle Support Web site at

http://www.oracle.com/support/index.html
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Appendix F
License and Copyright Notices

Third Party Products
Following topic is discussed in detail: 

Notice Concerning Usage of Mapping Data

Notice Concerning Usage of Mapping Data
This section includes the following: 

• Digital Map Data Provider

• eLocation's Regional Coverage

Digital Map Data Provider
Oracle Utilities Advanced Spatial and Operational Analytics require digital map data for providing 
the mapping functionality. This data could be obtained by licensing eLocation (http://
elocation.oracle.com), Oracle's Location Services. eLocation is a comprehensive location mapping 
tool that comprises a number of components including geo-coding, mapping and a routing engine. 
It uses Navigation Technologies Corporation's (NAVTEQ) data. 

eLocation's Regional Coverage
eLocation is currently licensed for background maps in Western Europe and North America. 
Refer http://elocation.oracle.com/elocation/legal.html for more information on eLocation’s 
regional coverage and Terms and Conditions. 

Customers outside the eLocation covered region or who don't license eLocation can license map 
data from Navteq or any other third party map data providers such as: 

• Google Maps

• Bing Maps

Oracle Utilities Advanced Spatial and Operational Analytics provide an easy plug-in feature to 
enable Google or Bing maps. 

For details on map data configuration, refer to Setting up a Third-Party Base Map on page 1-
32.
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